Blu-ray™ Disc Player
user manual

imagine the possibilities

Thank you for purchasing this Samsung product.
To receive more complete service, please register your product at
www.samsung.com/register
Safety Information

Warning

To reduce the risk of electric shock, do not remove the cover (or back). No user-serviceable parts are inside. Refer servicing to qualified service personnel.

FCC NOTE (for U.S.A)

This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to Part 15 of the FCC rules. These limits are designed to provide reasonable protection against harmful interference in a residential installation. This equipment generates, uses and can radiate radio frequency energy and, if not installed and used in accordance with the instructions, may cause harmful interference to radio or television reception, which can be determined by turning the equipment off and on. The user is encouraged to try to correct the interference by one or more of the following measures.

- Reorient or relocate the receiving antenna.
- Increase the separation between the equipment and receiver.
- Connect this equipment into an outlet on a circuit different from that to which the receiver is connected.
- Consult the dealer or an experienced radio/TV technician for help.

This class B digital product meets all requirements of the Canadian Interference - Causing Equipment Regulations.

Note to CATV system installer

This reminder is provided to call CATV system installer’s attention to Article 820-40 of the National Electrical Code (Section 54 of Canadian Electrical Code, Part I) that provides guidelines for proper grounding and, in particular, specifies that the cable ground shall be connected to the grounding system of the building as close to the point of cable entry as practical.

CLASS 1 LASER PRODUCT

This Compact Disc player is classified as a CLASS 1 LASER product. Use of controls, adjustments or performance of procedures other than those specified herein may result in hazardous radiation exposure.

Complies with 21CFR 1040.10 except for deviations pursuant to Laser Notice No. 50, dated June 24, 2007.

DANGER:

- VISIBLE AND INVISIBLE LASER RADIATION WHEN OPEN. AVOID DIRECT EXPOSURE TO BEAM. (FDA 21 CFR)

CAUTION:

- CLASS 3B VISIBLE AND INVISIBLE LASER RADIATION WHEN OPEN. AVOID EXPOSURE TO THE BEAM. (IEC 60825-1)
- THIS PRODUCT UTILIZES A LASER. USE OF CONTROLS OR ADJUSTMENTS OR PERFORMANCE OF PROCEDURES OTHER THAN THOSE SPECIFIED HEREIN MAY RESULT IN HAZARDOUS RADIATION EXPOSURE. DO NOT OPEN COVER AND DO NOT REPAIR YOURSELF. REFER SERVICING TO QUALIFIED PERSONNEL.

If the Region number of a Blu-ray Disc/DVDs does not correspond to the Region number of this player, the player cannot play the disc.
Precautions

Important Safety Instructions

Read these operating instructions carefully before using the unit. Follow all the safety instructions listed below. Keep these operating instructions handy for future reference.

1. Read these instructions.
2. Keep these instructions.
3. Heed all warnings.
4. Follow all instructions.
5. Do not use this apparatus near water.
6. Clean only with a dry cloth.
7. Do not block any ventilation openings. Install in accordance with the manufacturer’s instructions.
8. Do not install near any heat sources such as radiators, heat registers, stoves, or other apparatus (including AV receivers) that produce heat.
9. Do not defeat the safety purpose of the polarized or grounding-type plug. A polarized plug has two blades with one wider than the other. A grounding type plug has two blades and a third grounding prong. The wide blade or the third prong are provided for your safety. If the provided plug does not fit into your outlet, consult an electrician for replacement of the obsolete outlet.
10. Protect the power cord from being walked on or pinched particularly at plugs, convenience receptacles, and the point where it exits the apparatus.
11. Only use attachments/accessories specified by the manufacturer.
12. Use only with the cart, stand, tripod, bracket, or table specified by the manufacturer, or sold with the apparatus. When a cart is used, use caution when moving the cart/apparatus combination to avoid injury from tip-over.
13. Unplug this apparatus during lightning storms or when unused for long periods of time.
14. Refer all servicing to qualified service personnel. Servicing is required when the apparatus has been damaged in any way, such as when the power-supply cord or plug is damaged, liquid has been spilled or objects have fallen into the apparatus, the apparatus has been exposed to rain or moisture, does not operate normally, or has been dropped.

Disc Storage & Management

• Holding Discs
  - Fingerprints or scratches on a disc may reduce sound and picture quality or cause skipping.
  - Avoid touching the surface of a disc where data has been recorded.
  - Hold the disc by the edges so that fingerprints will not get on the surface.
  - Do not stick paper or tape on the disc.

• Cleaning Discs
  - If you get fingerprints or dirt on a disc, clean it with a mild detergent diluted in water and wipe with a soft cloth.
  - When cleaning, wipe gently from the inside to the outside of the disc.

• Disc Storage
  - Do not keep in direct sunlight.
  - Keep in a cool ventilated area.
  - Keep in a clean protection jacket and store vertically.

Handling Cautions

• Do not expose this apparatus to dripping or splashing. Do not put objects filled with liquids, such as vases on the apparatus.
• To turn this apparatus off completely, you must pull the power plug out of the wall socket. Consequently, the power plug must be easily and readily accessible at all times.
Safety Information

- Do not plug multiple electric devices into the same wall socket. Overloading a socket can cause it to overheat, resulting in a fire.
- Before connecting other components to this player, be sure to turn them off.
- If you move your player suddenly from a cold place to a warm place, condensation may occur on the operating parts and lens and cause abnormal disc playback. If this occurs, unplug the player, wait for two hours, and then connect the plug to the power outlet. Then, insert the disc, and try to play back again.
- If the product makes an abnormal noise or produces a burning smell or smoke, turn off the power switch immediately and disconnect the power plug from the wall outlet. Then, contact the nearest customer service center for technical assistance. Do not use the product. Using the product as it is may cause a fire or an electric shock.

Using the 3D function

IMPORTANT HEALTH AND SAFETY INFORMATION FOR 3D PICTURES.
Read and understand the following safety information before using the 3D function.
- Some viewers may experience discomfort while viewing 3D TV such as dizziness, nausea, and headaches.
  If you experience any such symptom, stop viewing 3D TV, remove the 3D Active Glasses, and rest.
- Watching 3D images for an extended period of time may cause eye strain. If you feel eye strain, stop viewing 3D TV, remove your 3D Active Glasses, and rest.
- A responsible adult should frequently check on children who are using the 3D function.
  If there are any reports of tired eyes, headaches, dizziness, or nausea, have the child stop viewing 3D TV and rest.
- Do not use the 3D Active Glasses for other purposes (Such as general eyeglasses, sunglasses, protective goggles, etc.).
- Do not use the 3D function or 3D Active Glasses while walking or moving around. Using the 3D function or 3D Active Glasses while moving around may cause you to bump into objects, trip, and/or fall, and cause serious injury.
- If you want to enjoy 3D content, connect a 3D device (3D compliant AV receiver or TV) to the player’s HDMI OUT port using a high-speed HDMI cable. Put on 3D glasses before playing the 3D content.
- The player outputs 3D signals only through HDMI cable connected to the HDMI OUT port.
- As the video resolution in 3D play mode is fixed according to the resolution of the original 3D video, you can not change the resolution to your preference.
- Some functions such as BD Wise, screen size adjustment, and resolution adjustment may not operate properly in 3D play mode.
- You must use a high-speed HDMI cable for proper output of the 3D signal.
- Stay at least three times the width of the screen from the TV when watching 3D images. For example, if you have a 46-inch screen, stay 138 inches (11.5 feet) from the screen.
- Place the 3D video screen at eye level for the best 3D picture.
- When the player is connected to some 3D devices, the 3D effect may not function properly.
- This player does not convert 2D content into 3D.
- "Blu-ray 3D" and "Blu-ray 3D" logo are trademarks of the Blu-ray Disc Association.

Copyright

© 2013 Samsung Electronics Co.,Ltd.
All rights reserved; No part or whole of this user’s manual may be reproduced or copied without the prior written permission of Samsung Electronics Co.,Ltd.
## SAFETY INFORMATION

2 Warning  
3 Precautions  
3 Important Safety Instructions  
3 Disc Storage & Management  
4 Handling Cautions  
4 Using the 3D function  
4 Copyright

## GETTING STARTED

7 Disc and Format Compatibility  
7 Disc types and contents your player can play  
7 Disc types your player cannot play  
8 Region Code  
8 Logos of Discs the player can play  
9 Supported Formats  
12 Accessories  
13 Front Panel  
13 Rear Panel  
14 Remote Control  
14 Tour of the Remote Control

## CONNECTIONS

15 Connecting to a TV  
16 Connecting to an Audio System  
16 Method 1 Connecting to an HDMI supported AV receiver  
16 Method 2 Connecting to an AV receiver with Dolby Digital or DTS decoder  
17 Connecting to a Network Router  
17 Wired Network  
17 Wireless Network

## SETTINGS

18 The Initial Settings Procedure  
18 The Home Screen  
19 Accessing the Settings Screen  
19 Buttons on the Remote Control Used for the Settings Menu  
20 Settings Menu Functions  
26 Networks and the Internet  
26 Configuring Your Network Connection  
29 Wi-Fi Direct  
30 Upgrading Software  
30 Update Now  
31 Auto Update

## MEDIA PLAY

32 The AllShare Play Screen  
32 Accessing the AllShare Play Screen  
32 Playing Commercial Discs  
32 Playing Files on a USB Device  
33 Playing a Disc with User Recorded Content  
34 Using the Allshare Network Function  
34 To Download the Allshare Software  
35 Playing Content Located on Your PC or Allshare Device through the Blu-ray Disc Player  
35 Controlling the Playback of Content Located on Your PC with Your Smart Phone  
36 Controlling Video Playback  
36 Buttons on the Remote Control used for Video Playback  
36 Using the Tools Menu  
38 Using the View & Options Menus
Controlling Music Playback
Buttons on the Remote Control used for Music Playback
Using the View & Options Menus
Repeating Tracks on an Audio CD
Shuffling Tracks on an Audio CD
Creating a Playlist from an Audio CD
Ripping
Playing Photo Contents
Using the Tools Menu
Using the View & Options Menus
Using the Send Function

NETWORK SERVICES
Logging In to Your Samsung Account
Before Using Movies & TV Shows or Apps
Using Movies & TV Shows
Using Apps
The Apps Screen at a Glance
Downloading Applications
Starting an Application
Using the Downloaded Screen
Sorting the Apps
Using the Edit Menu Functions

Screen Mirroring
Using the Web Browser
Link Browsing and Pointer Browsing
The Control Panel at a Glance
Using the Setting Menu
Linking Your Internet Service Accounts to the Player
BD-LIVE™

APPENDIX
Compliance and Compatibility Notice
Copy Protection
Network Service Disclaimer
License
Additional Information
Notes
Resolution according to the contents type
Digital Output Selection
Troubleshooting
Repairs
Specifications
Disc and Format Compatibility

Disc types and contents your player can play

<table>
<thead>
<tr>
<th>Media</th>
<th>Disc Type</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>VIDEO</td>
<td>Blu-ray Disc, 3D Blu-ray Disc</td>
<td>BD-ROM or BD-RE/-R recorded in the BD-RE format.</td>
</tr>
<tr>
<td></td>
<td>DVD-VIDEO, DVD-RW, DVD-R, DVD+RW, DVD+R</td>
<td>DVD-VIDEO, recorded DVD+RW/DVD-RW(V)/DVD-R/+R that have been recorded and finalized, or a USB storage media containing MKV, MP4 contents.</td>
</tr>
<tr>
<td>MUSIC</td>
<td>CD-RW/-R, DVD-RW/-R, BD-RE/-R</td>
<td>Music recorded on CD-RW/-R, DVD-RW/-R, BD-RE/-R or a USB storage media containing MP3 or WMA contents.</td>
</tr>
</tbody>
</table>

NOTES

- The player may not play certain CD-RW/-R and DVD-R because of the disc type or recording conditions.
- If a DVD-RW/-R has not been recorded properly in DVD video format, it will not be playable.
- Your player will not play content that has been recorded on a DVD-R at a bit-rate that exceeds 10 Mbps.
- Your player will not play content that has been recorded on a BD-R or USB device at a bitrate that exceeds 25 Mbps.
- Playback may not work for some types of discs, or when you use specific functions, such as angle change and aspect ratio adjustment. Information about the discs is written in detail on the disc box. Please refer to this if necessary.
- When you play a BD-J title, loading may take longer than a normal title or some functions may perform slowly.

Disc types your player cannot play

- HD DVD
- DVD-ROM/PD/MV, etc
- DVD-RAM
- Super Audio CD (except CD layer)
- DVD-RW (VR mode)
- CVD/CD-ROM/CDV/CD-G/CD-I/LD (CD-Gs play audio only, not graphics.)
- 3.9 GB DVD-R for Authoring.
### Region Code

Both players and discs are coded by region. These regional codes must match for a disc to play. If the codes do not match, the disc will not play.

The Region Number for this player is displayed on the rear panel of the player.

<table>
<thead>
<tr>
<th>Disc Type</th>
<th>Region Code</th>
<th>Area</th>
</tr>
</thead>
<tbody>
<tr>
<td>Blu-ray Disc</td>
<td>A</td>
<td>North America, Central America, South America, Korea, Japan, Taiwan, Hong Kong and South East Asia.</td>
</tr>
<tr>
<td></td>
<td>b</td>
<td>Europe, Greenland, French territories, Middle East, Africa, Australia and New Zealand.</td>
</tr>
<tr>
<td></td>
<td>c</td>
<td>India, China, Russia, Central and South Asia.</td>
</tr>
<tr>
<td>DVD-VIDEO</td>
<td>1</td>
<td>The U.S., U.S. territories and Canada</td>
</tr>
<tr>
<td></td>
<td>2</td>
<td>Europe, Japan, the Middle East, Egypt, Africa, Greenland</td>
</tr>
<tr>
<td></td>
<td>3</td>
<td>Taiwan, Korea, the Philippines, Indonesia, Hong Kong</td>
</tr>
<tr>
<td></td>
<td>4</td>
<td>Mexico, South America, Central America, Australia, New Zealand, Pacific Islands, Caribbean</td>
</tr>
<tr>
<td></td>
<td>5</td>
<td>Russia, Eastern Europe, India, North Korea, Mongolia</td>
</tr>
<tr>
<td></td>
<td>6</td>
<td>China</td>
</tr>
</tbody>
</table>

**Logos of Discs the player can play**

- Blu-ray Disc
- 3D Blu-ray Disc
- **NTSC**

**BD-LIVE**

- NTSC broadcast system in U.S.A, Canada, Korea, Japan
## Supported Formats

### Video File Support

<table>
<thead>
<tr>
<th>File Extension</th>
<th>Container</th>
<th>Video Codec</th>
<th>Resolution</th>
<th>Frame rate (fps)</th>
<th>Bitrate (Mbps)</th>
<th>Audio Codec</th>
</tr>
</thead>
<tbody>
<tr>
<td>*.avi</td>
<td>AVI</td>
<td>MPEG4 SP/ASP</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>*.mkv</td>
<td>MKV</td>
<td>H.264 BP/MP/HP</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>*.asf</td>
<td>ASF</td>
<td>Motion JPEG</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>*.mp4</td>
<td>MP4</td>
<td>Microsoft MPEG-4 v3</td>
<td>1920x1080 (WMV v7,v8, MSMPEG4 v3 : 1280x720)</td>
<td>6–30</td>
<td>30</td>
<td>Dolby Digital LPCM</td>
</tr>
<tr>
<td>*.3gp</td>
<td>3GP</td>
<td>Window Media Video v7,v8,v9</td>
<td></td>
<td></td>
<td></td>
<td>ADPCM(IMA, MS)</td>
</tr>
<tr>
<td>*.vro</td>
<td>VRO</td>
<td>MPEG2</td>
<td></td>
<td></td>
<td></td>
<td>AAC</td>
</tr>
<tr>
<td>*.mpg</td>
<td>MOV</td>
<td>VP6</td>
<td>640x480</td>
<td>4</td>
<td></td>
<td>HE-AAC</td>
</tr>
<tr>
<td>*.mpeg</td>
<td>FLV</td>
<td>VP8</td>
<td>1920x1080</td>
<td>6–30</td>
<td>20</td>
<td>WMA</td>
</tr>
<tr>
<td>*.ts</td>
<td>VOB</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Dolby Digital Plus</td>
</tr>
<tr>
<td>*.tp</td>
<td>PS</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>MPEG(MP3)</td>
</tr>
<tr>
<td>*.trp</td>
<td>TS</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>DTS (Core)</td>
</tr>
<tr>
<td>*.mov</td>
<td>SVAF</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>*.flv</td>
<td>PS</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>*.vob</td>
<td>TS</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>*.svi</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>*.m2ts</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>*.mts</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>*.webm</td>
<td>WebM</td>
<td>VP8</td>
<td>1920x1080</td>
<td>6–30</td>
<td>20</td>
<td>Vorbis</td>
</tr>
</tbody>
</table>

### Limitations

- Even when the file is encoded by a supported codec listed above, a file might not be played if its content is defective or corrupted.
- Normal playback is not guaranteed if the file’s container information is wrong or the file itself is corrupted.
- Files having higher bit or frame rates than indicated in the table above may stutter when played back.
- The Seek (Jump) function is not available if the file's index table is damaged.
- When you playback a file remotely through a network connection, video playback may stutter depending on the network speed.
- Some USB/Digital camera devices may not be compatible with the product.

### Video decoder

- Supports up to H.264 Level 4.1. (Does not support FMO/ASO/RS)
- Does not support VC1/AP/L4.
Getting Started

- CODECs except for WMVv7, v8, MSMPEG4 v3, MVC, VP6
  1) Below 1280 x 720: 60 frames max.
  2) Above 1280 x 720: 30 frames max.
- Does not support GMC 2 or higher.
- Supports SVAF (Top/Bottom, Side by Side).
- Supports BD MVC Spec.

  ■ Audio decoder
  - Supports WMA 10 PRO (Up to 5.1).
  - Does not support WMA lossless audio.
  - Supports ADPCM IMA, MS.
  - Does not support ADPCM(A-Law, μ-Law).
  - Does not support QCELP/AMR NB/WB.
  - Supports vorbis (Up to 2ch).
  - Supports DD+ (Up to 7.1ch)

<table>
<thead>
<tr>
<th>NOTES</th>
</tr>
</thead>
</table>
| ▶ Playback of some MKV or MP4 file may not be supported depending on their video resolution and frame rate.

### Supported Subtitle File Formats

<table>
<thead>
<tr>
<th>Name</th>
<th>File Extension</th>
</tr>
</thead>
<tbody>
<tr>
<td>External</td>
<td></td>
</tr>
<tr>
<td>MPEG-4 Timed text</td>
<td>.txt</td>
</tr>
<tr>
<td>SAMI</td>
<td>.smi</td>
</tr>
<tr>
<td>SubRip</td>
<td>.srt</td>
</tr>
<tr>
<td>SubViewer</td>
<td>.srt</td>
</tr>
<tr>
<td>Micro DVD</td>
<td>.sub or .txt</td>
</tr>
<tr>
<td>SubStation Alpha</td>
<td>.ssa</td>
</tr>
<tr>
<td>Advanced SubStation Alpha</td>
<td>.ass</td>
</tr>
<tr>
<td>Powerd1x</td>
<td>.psb</td>
</tr>
<tr>
<td>Internal</td>
<td></td>
</tr>
<tr>
<td>Xsub</td>
<td>AVI</td>
</tr>
<tr>
<td>SubStation Alpha</td>
<td>MKV</td>
</tr>
<tr>
<td>Advanced SubStation Alpha</td>
<td>MKV</td>
</tr>
<tr>
<td>SubRip</td>
<td>MKV</td>
</tr>
<tr>
<td>MPEG-4 Timed text</td>
<td>MP4</td>
</tr>
</tbody>
</table>

### Music File Support

<table>
<thead>
<tr>
<th>File Extension</th>
<th>Type</th>
<th>Codec</th>
<th>Support Range</th>
</tr>
</thead>
<tbody>
<tr>
<td>*.mp3</td>
<td>MPEG</td>
<td>MPEG1 Audio</td>
<td>-</td>
</tr>
<tr>
<td>*.m4a</td>
<td></td>
<td>MPEG4 AAC</td>
<td>-</td>
</tr>
<tr>
<td>*.mpa</td>
<td></td>
<td></td>
<td>-</td>
</tr>
<tr>
<td>*.aac</td>
<td></td>
<td></td>
<td>-</td>
</tr>
<tr>
<td>*.flac</td>
<td>FLAC</td>
<td>FLAC</td>
<td>Supports up to 2ch</td>
</tr>
<tr>
<td>*.ogg</td>
<td>OGG</td>
<td>Vorbis</td>
<td>Supports up to 2ch</td>
</tr>
<tr>
<td>*.wav</td>
<td>wav</td>
<td>wav</td>
<td>-</td>
</tr>
<tr>
<td>*.mid</td>
<td>midi</td>
<td>midi</td>
<td>type 0 and type 1</td>
</tr>
<tr>
<td>*.ape</td>
<td>ape</td>
<td>ape</td>
<td>-</td>
</tr>
<tr>
<td>*.mp3</td>
<td>ASCII</td>
<td>ASCII</td>
<td>-</td>
</tr>
<tr>
<td>*.m4a</td>
<td>ASCII</td>
<td>ASCII</td>
<td>-</td>
</tr>
<tr>
<td>*.mpa</td>
<td>ASCII</td>
<td>ASCII</td>
<td>-</td>
</tr>
<tr>
<td>*.aac</td>
<td>ASCII</td>
<td>ASCII</td>
<td>-</td>
</tr>
<tr>
<td>*.flac</td>
<td>ASCII</td>
<td>ASCII</td>
<td>-</td>
</tr>
<tr>
<td>*.ogg</td>
<td>ASCII</td>
<td>ASCII</td>
<td>-</td>
</tr>
<tr>
<td>*.wav</td>
<td>ASCII</td>
<td>ASCII</td>
<td>-</td>
</tr>
<tr>
<td>*.mid</td>
<td>ASCII</td>
<td>ASCII</td>
<td>-</td>
</tr>
<tr>
<td>*.ape</td>
<td>ASCII</td>
<td>ASCII</td>
<td>-</td>
</tr>
</tbody>
</table>

### Picture File Support

<table>
<thead>
<tr>
<th>File Extension</th>
<th>Type</th>
<th>Resolution</th>
</tr>
</thead>
<tbody>
<tr>
<td>*.jpg</td>
<td>JPEG</td>
<td>15360x8640</td>
</tr>
<tr>
<td>*.jpeg</td>
<td>JPEG</td>
<td>15360x8640</td>
</tr>
<tr>
<td>*.png</td>
<td>PNG</td>
<td>4096x4096</td>
</tr>
<tr>
<td>*.bmp</td>
<td>BMP</td>
<td>4096x4096</td>
</tr>
<tr>
<td>*.mpo</td>
<td>MPO</td>
<td>15360x8640</td>
</tr>
</tbody>
</table>
Notes on the USB connection

- Your player supports USB storage media, MP3 players, digital cameras, and USB card readers.
- Some USB/digital camera devices may not be compatible with the player.
- Your player supports the FAT16, FAT32, and NTFS file systems.
- Connect USB devices directly to the player’s USB port. Connecting through a USB cable may cause compatibility problems.
- Inserting more than one memory device into a multi-card reader may cause the reader to operate improperly.
- The player does not support the PTP protocol.
- Do not disconnect a USB device during a "loading" process.
- The bigger the image resolution, the longer the image takes to display.
- This player cannot play MP3 files with DRM (Digital Rights Management) downloaded from commercial sites.
- Your player only supports video that is under 30fps (frame rate).
- Your player only supports USB Mass Storage Class (MSC) devices such as thumb drives and USB HDD. (HUB is not supported.)
- Certain USB HDD Devices, multi-card readers and thumb drives may not be compatible with this player.
- If some USB devices require excessive power, they may be limited by the circuit safety device.
- If playback from a USB HDD is unstable, provide additional power by plugging the HDD into a wall socket. If the problem continues, contact the USB HDD manufacturer.
- SAMSUNG is not responsible for any data file damage or data loss.
- Your player does not support NTFS compressed, sparse, or encrypted files.
  - You can repair or format a USB device on your Desktop PC. (MS-Windows OS only)

AVCHD (Advanced Video Codec High Definition)

- This player can play back AVCHD format discs. These discs are normally recorded and used in camcorders.
- The AVCHD format is a high definition digital video camera format.
- The MPEG-4 AVC/H.264 format compresses images with greater efficiency than the conventional image compressing format.
- Some AVCHD discs use the "x.v.Color" format. This player can play back AVCHD discs that use "x.v.Color" format.
- "x.v.Color" is a trademark of Sony Corporation.
- "AVCHD" and the AVCHD logo are trademarks of Matsushita Electronic Industrial Co., Ltd. and Sony Corporation.

NOTES

- Some AVCHD format discs may not play, depending on the recording conditions. AVCHD format discs need to be finalized.
- "x.v.Color" offers a wider color range than normal DVD camcorder discs.
Getting Started

Accessories

Check for the supplied accessories shown below.

<table>
<thead>
<tr>
<th>Batteries for Remote Control (AAA Size) (4301-000121)</th>
<th>HDMI cable (BD-FM59C only) (GL39-00121A)</th>
</tr>
</thead>
<tbody>
<tr>
<td>[Image of Batteries]</td>
<td>[Image of HDMI Cable]</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>User Manual (AK68-02355A)</th>
<th>Quick Setup Guide (AK68-02232U)</th>
<th>Remote Control (AK59-00166A)</th>
</tr>
</thead>
<tbody>
<tr>
<td>[Image of User Manual]</td>
<td>[Image of Quick Setup Guide]</td>
<td>[Image of Remote Control]</td>
</tr>
</tbody>
</table>
To upgrade the player’s software through the USB Host jack, you must use a USB memory stick.

When the player displays the Blu-ray Disc menu, you cannot start the movie by pressing the Play button on the player or the remote control. To play the movie, you must select Play Movie or Start in the disc menu, and then press the \( \text{Play} \) button on the remote control.
Getting Started

Remote Control

Tour of the Remote Control

| After setup, allows you to set the input source on your TV. (This button is only available in Samsung TV.) |
| Turn the player on and off. |
| Press to open and close the disc tray. |
| Press the number buttons to operate options. |
| Use to enter the disc menu. |
| Press to skip backwards or forwards. |
| Press to stop a disc. |
| Press to move to the Home screen. |
| Press to use Netflix. |
| Press to use the Tools menu. |
| Return to the previous menu. |
| These buttons are used both for menus on the player and also several Blu-ray Disc functions. Press to search contents. |
| Use to access various audio functions on a disc. |

Installing batteries

| NOTES |
| If the remote control does not operate properly: |
| - Check the polarity +/- of the batteries. |
| - Check if the batteries are drained. |
| - Check if the remote sensor is blocked by obstacles. |
| - Check if there is any fluorescent lighting nearby. |

| CAUTION |
| Dispose of batteries according to local environmental regulations. Do not put them in the household trash. |
Connecting to a TV

Connect an HDMI cable (not supplied) from the HDMI OUT jack on the back of the product to the HDMI IN jack on your TV.

- Do not connect the power cord to the wall outlet until you have made all the other connections.
- When you change the connections, turn off all devices before you start.

NOTES

- If you use an HDMI-to-DVI cable to connect to your display device, you must also connect the Digital Audio Out on the player to an audio system to hear audio.
- An HDMI cable outputs digital video and audio, so you don’t need to connect an audio cable.
- Depending on your TV, certain HDMI output resolutions may not work. Please refer to the user manual of your TV.
- When you connect the player to your TV using the HDMI cable or to a new TV, and then turn it on for the first time, the player automatically sets the HDMI output resolution to the highest supported by the TV.
- A long HDMI cable may cause screen noise. If this occurs, set HDMI Deep Color to Off in the menu.
- To view video in the HDMI 720p, 1080i, or 1080p output mode, you must use a High speed (category 2) HDMI cable.
- HDMI outputs only a pure digital signal to the TV.
  If your TV does not support HDCP (High-bandwidth Digital Content Protection), random noise appears on the screen.
Connecting to an Audio System

You can connect the Blu-ray player to the audio system using the methods illustrated below.
- Do not connect the power cord to the wall outlet until you have made all the other connections.
- When you change the connections, turn off all devices before you start.

Method 1  Connecting to an HDMI supported AV receiver

- Connect an HDMI cable (not supplied) from the HDMI OUT jack on the back of the product to the HDMI IN jack on your receiver.
- Best quality (Recommended)

Method 2  Connecting to an AV receiver with Dolby Digital or DTS decoder

- Using a digital Optical cable (not supplied), connect the Optical Digital Audio Out jack on the product to the Digital Optical In jack of the receiver.
- Good quality
- You will hear sound only through the front two speakers with Digital Output set to PCM.
Connecting to a Network Router

You can connect your player to your network router using one of the methods illustrated below. To use the AllShare network functionality, you must connect your PC to your network as shown in the illustrations. The connection can be wired or wireless.

Wired Network

Wireless Network

<table>
<thead>
<tr>
<th>NOTES</th>
</tr>
</thead>
<tbody>
<tr>
<td>Your router or your Internet Service Provider’s policies may prevent the player from accessing Samsung’s software update server. If this occurs, contact your Internet Service Provider (ISP) for more information.</td>
</tr>
<tr>
<td>DSL users, please use a router to make a network connection.</td>
</tr>
<tr>
<td>NOTES</td>
</tr>
<tr>
<td>If your wireless router supports DHCP, this player can use a DHCP or static IP address to connect to the wireless network.</td>
</tr>
<tr>
<td>Set your wireless router to Infrastructure mode. Ad-hoc mode is not supported.</td>
</tr>
<tr>
<td>The player supports only the following wireless security key protocols:</td>
</tr>
<tr>
<td>- WEP (OPEN/SHARED), WPA-PSK (TKIP/AES), WPA2-PSK (TKIP/AES)</td>
</tr>
<tr>
<td>Select a channel on the wireless router that is not currently being used. If the channel set for the wireless router is currently being used by another device nearby, it will result in interference and communication failure.</td>
</tr>
<tr>
<td>If you select the Pure High-throughput (Greenfield) 802.11n mode and set the Encryption type on your router to WEP, TKIP or TKIP-AES (WPS2Mixed), the player will not support a connection in compliance with new Wi-Fi certification specifications.</td>
</tr>
<tr>
<td>Wireless LAN, by its nature, may cause interference, depending on the operating conditions (router performance, distance, obstacles, interference by other radio devices, etc).</td>
</tr>
</tbody>
</table>
Settings

The Initial Settings Procedure

- The Home screen will not appear if you do not configure the initial settings.
- The OSD (On Screen Display) may change in this player after you upgrade the software version.
- The access steps may differ depending on the menu you selected.

After you have connected the player to your TV, turn on the TV and player. When you turn on the player the first time, the player’s Initial Settings screen appears on the TV. The Initial Setting procedure lets you set the On Screen Display (OSD) and menu languages, the aspect ratio (screen size), the network type, and connect the player to your network. For complete Initial Settings instructions, see the Quick Setup Guide.

<table>
<thead>
<tr>
<th>NOTES</th>
</tr>
</thead>
</table>
- If you skip Network Setup during the Initial Settings procedure, you can configure your network settings later. See “Configuring Your Network Connection” on pages 26–29 for instructions.
- If you want to display the Initial Settings screen again and make changes, select Settings > System > Setup in the Home screen or select the Reset option. (See pages 22 or 25)
- If you want to use an Anynet+(HDMI-CEC) function, please follow the instructions below.
  1) Connect the player to an Anynet+(HDMI-CEC)-compliant Samsung TV using HDMI Cable.
  2) Set the Anynet+(HDMI-CEC) feature to On in both the TV and the player.
  3) Set the TV to the Initial Settings Procedure.

The Home Screen

- Apps: Gives you access to various for pay or free-of-charge applications you can download.
- Photos, Videos & Music: Lets you play photos, videos or music content from Disc, USB, PC or mobile devices.
- Settings: Opens the player’s menu where you can set various functions to suit your personal preferences.
- Web Browser: Provides access to the Internet.
- Recommended Apps: Gives you direct access to recommended applications.
- Movies & TV Shows: Lets you download movies and TV Shows from the Internet.

<table>
<thead>
<tr>
<th>NOTES</th>
</tr>
</thead>
</table>
- Depending on your country, this menu function may not be supported.

<table>
<thead>
<tr>
<th>NOTES</th>
</tr>
</thead>
</table>
- If you leave the player in the stop mode for more than 5 minutes without using it, a screen saver will appear on your TV. If the player is left in the screen saver mode for more than 20 minutes, the power will automatically turn off.
## Accessing the Settings Screen

1. Select **Settings** on the Home screen, and then press button. The Settings screen appears.

2. To access the menus, sub-menus, and options on the Settings screen, please refer to the remote control illustration below.

### Buttons on the Remote Control Used for the Settings Menu

- **HOME** Button: Press to move to the Home screen.
- **RETURN** Button: Return to the previous menu.
- (Enter) / DIRECTION Buttons:
  - Press ▲▼◄► to move the cursor or select an item.
  - Press the button to activate the currently selected item or confirm a setting.
- **EXIT** Button: Press to exit the current menu.

## Detailed Function Information

Each Settings function, menu item, and individual option is explained in detail on-screen. To view an explanation, use the ▲▼◄► buttons to select the function, menu item, or option. The explanation will usually appear on the right side of the screen. A short description of each Settings function starts on the next page. Additional information on some of the functions is also in the Appendix of this manual.

### Display

- **TV Aspect Ratio 16:9 Original**
- **BD Wise Off**
- **Resolution Auto**
- **Movie Frame (24Fs) Auto**
- **DVD 24fps Conversion Off**
- **Smart Hub Screen Size Size 3**

### Audio

### Network

### Smart Features

### System

### Support
## Settings Menu Functions

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Display</strong></td>
<td></td>
</tr>
</tbody>
</table>
| **3D Settings**       | Select whether to play a Blu-ray Disc with 3D contents in 3D Mode.  
  • If you move to the Home or Smart Hub Home screen while in 3D mode, the player will switch to 2D automatically. |
| **TV Aspect Ratio**   | Lets you adjust the output of the player to the screen size and screen format of your TV.                                                   |
| **BD Wise**           | BD Wise is Samsung’s latest inter-connectivity feature. When you connect a Samsung player and a Samsung TV with BD Wise to each other via HDMI, and BD Wise is on in both the player and TV, the player outputs video at the video resolution and frame rate of the Blu-ray Disc/DVD. |
| **Resolution**        | Set the output resolution of the HDMI video signal to BD Wise, Auto, 1080p, 1080i, 720p or 480p. The number indicates the number of lines of video per frame. The i and p indicate interlaced and progressive scan, respectively. Generally, the more lines, the higher quality. |
| **Movie Frame (24Fs)**| If the player is connected to a 24Fs compatible TV, setting the Movie Frame (24Fs) feature to Auto lets the player adjust its HDMI output to 24 frames per second automatically for improved picture quality.  
  • You can enjoy the Movie Frame (24Fs) feature only on a TV supporting this frame rate.  
  • Movie Frame is only available when the player is in the HDMI 1080i or 1080p output resolution modes. |
| **DVD 24Fs Conversion**| Converts DVD playback to 24 frames per second and outputs it via HDMI. This option is only available when Movie Frame (24Fs) is set to on. |
| **Smart Hub Screen Size**| Lets you select the optimal size for the Smart Hub Screen. |
| **HDMI Color Format** | Lets you set the color space format for the HDMI output so that it matches the capabilities of the connected device (TV, monitor, etc). The screen goes black momentarily after you have selected a format. |
| **HDMI Deep Color**   | Lets you set the product to output HDMI video with Deep Color. Deep Color provides more accurate color reproduction with greater color depth. |
| **Progressive Mode**  | Lets you improve picture quality when viewing DVDs. |

---

20 English
### Audio

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Digital Output</td>
<td>Lets you select the digital audio output format that is suitable for your TV or AV Receiver. For more details, see the digital output selection table on page 62.</td>
</tr>
<tr>
<td>PCM Downsampling</td>
<td>Lets you choose to have 96Khz PCM signals downsampled to 48Khz before they are outputted to an amplifier. Choose <strong>On</strong> if your amplifier or receiver is not compatible with a 96Khz signal.</td>
</tr>
</tbody>
</table>
| Dynamic Range Control    | Lets you apply dynamic range control to Dolby Digital, Dolby Digital Plus, and Dolby TrueHD audio.  
  ✓ **Auto** : Automatically controls the dynamic range of Dolby TrueHD audio, based on information in the Dolby TrueHD soundtrack. Also turns dynamic range control on for Dolby Digital and Dolby Digital Plus.  
  ✓ **Off** : Leaves the dynamic range uncompressed, letting you hear the original sound.  
  ✓ **On** : Turns dynamic range control on for all three Dolby formats. Quieter sounds are made louder and the volume of loud sounds is reduced. |
| Downmixing Mode          | Lets you select the multi-channel downmix method that is compatible with your stereo system. You can choose to have the player downmix to normal stereo or to surround compatible stereo. |
| DTS Neo:6 Mode           | You can enjoy multichannel sound via HDMI output from a 2 channel audio source.                                                               |

### Network

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Network Status</td>
<td>Lets you check the current network and Internet status.</td>
</tr>
<tr>
<td>Network Settings</td>
<td>Configure the network connection so you can enjoy various features such as Internet services or AllShare Wi-Fi functionality, and perform Software Updates.</td>
</tr>
</tbody>
</table>
| Wi-Fi Direct             | Lets you connect a Wi-Fi Direct device to the player using a peer-to-peer network, without the need for a wireless router.  
  Note that if the player is connected to a wireless network, it may be disconnected when you use Wi-Fi Direct. |

**NOTES**
- Text files, such as files with a .TXT or .DOC extension, will not display when you are using the Wi-Fi Direct function.
### Network

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>AllShare Settings</td>
<td>Lets you control which devices on your network, such as smart phones and tablets, can share content with your TV.</td>
</tr>
<tr>
<td>Device Name</td>
<td>Lets you input a name for the player that will identify it on your networks.</td>
</tr>
<tr>
<td>BD-Live Settings</td>
<td>Set various BD-Live functions. BD-Live allows you to access extra features available on some Blu-ray Discs if you are connected to the Internet.</td>
</tr>
<tr>
<td></td>
<td>✓ <strong>BD-Live Internet Connection</strong>: Lets you fully allow, partly allow, or prohibit a BD-Live Internet connection.</td>
</tr>
<tr>
<td></td>
<td>✓ <strong>BD Data Management</strong>: Manage BD data downloaded from a BD-Live service or Blu-ray Disc.</td>
</tr>
</tbody>
</table>

### Smart Features

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Apps Settings</td>
<td>Lets you configure App notification settings and view basic info about your Apps.</td>
</tr>
<tr>
<td></td>
<td>✓ <strong>Push Notification Settings</strong>: Receive notifications from selected services.</td>
</tr>
<tr>
<td></td>
<td>✓ <strong>Properties</strong>: See basic info about Apps.</td>
</tr>
<tr>
<td>VOD Rating Lock</td>
<td>You can lock access to Video on Demand (VOD) content based on its rating.</td>
</tr>
<tr>
<td>Terms &amp; Conditions, Privacy Policy</td>
<td>You must review and agree to both the Smart Hub Terms &amp; Conditions and the privacy policy in order to enjoy Smart Hub services.</td>
</tr>
<tr>
<td>Reset Smart Hub</td>
<td>Resets the Smart Hub and Samsung account settings stored on your device.</td>
</tr>
</tbody>
</table>

### System

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Setup</td>
<td>Lets you re-run the Initial Settings procedure. See the Quick Setup Guide for details.</td>
</tr>
<tr>
<td>Quick Start</td>
<td>Lets you set the player to turn on quickly by decreasing the boot time.</td>
</tr>
<tr>
<td>Quick Notes</td>
<td>If this function is set to On, Standby power consumption will be increased.</td>
</tr>
<tr>
<td>Language</td>
<td>You can select the language you prefer for the On-screen menu, disc menu, audio, subtitles, etc.</td>
</tr>
<tr>
<td></td>
<td>• The language you select for the disc menu, disc audio, or subtitles will only appear if it is supported on the disc.</td>
</tr>
</tbody>
</table>
You can connect a wireless USB keyboard or mouse to the USB port on the front of the player.

- **Keyboard Settings**: Lets you configure a wireless USB keyboard connected to the player.

<table>
<thead>
<tr>
<th>NOTES</th>
</tr>
</thead>
<tbody>
<tr>
<td>You can use the keyboard only when a QWERTY keyboard screen or window appears in the Web Browser.</td>
</tr>
</tbody>
</table>

- **Mouse Settings**: Lets you configure a wireless USB mouse connected to the player. You can use the mouse in the player’s menu and the Web Browser in the same way you use a mouse on your PC.

<table>
<thead>
<tr>
<th>NOTES</th>
</tr>
</thead>
<tbody>
<tr>
<td>Some USB HID keyboards and mice may not be compatible with your product.</td>
</tr>
<tr>
<td>Some HID keyboard keys may not work.</td>
</tr>
<tr>
<td>Wired USB keyboards are not supported.</td>
</tr>
<tr>
<td>Some applications may not be supported.</td>
</tr>
<tr>
<td>If a wireless HID Keyboard does not operate because of interference, move the keyboard closer to the player.</td>
</tr>
</tbody>
</table>

To use a mouse with the player’s menu:

1. Connect the USB mouse to the player.
2. Click the primary button you selected in Mouse Settings. The Simple Menu appears.
3. Click the menu options you want.
## System

### Security

- The default security PIN is 0000. Enter the default PIN to access the security function if you haven’t created your own PIN. After you have accessed the security function for the first time, change the PIN using the Change PIN function.
- **BD Parental Rating**: Prevents playback of Blu-ray Discs with a rating equal to or above a specific age rating you have set unless the PIN is entered.
- **DVD Parental Rating**: Prevents playback of DVDs with a rating above a specific numerical rating you have set unless the PIN is entered.
- **Change PIN**: Change the 4-digit PIN used to access security functions.

- **If you forget your PIN:**
  1. Remove any disc or USB storage device.
  2. Press and hold the button on the top panel for 5 seconds or more. All settings will revert to the factory default settings.

### General

You can change the options listed below to match your preferences.

- **Time Zone**: Select the time zone in which you live.
- **Menu Transparency**: Adjust the transparency of the menu box.

### Anynet+ (HDMI-CEC)

Anynet+ is a convenient function that offers linked operations with other Samsung players that have the Anynet+ feature and lets you control those products with one Samsung TV remote. To operate this function, you must connect this player to an Anynet+ Samsung TV using an HDMI cable.
<table>
<thead>
<tr>
<th>Support</th>
<th>When activated, lets Samsung Call Center agents diagnose and fix problems with the product remotely. Requires an active Internet connection.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>NOTES</strong></td>
<td>▶ Remote Management service might not be available in some countries.</td>
</tr>
<tr>
<td></td>
<td>▶ Contact your nearest service center for your PIN code and tell the code to the person in charge. It enables remote diagnosis of the product and required measures.</td>
</tr>
<tr>
<td>Remote Management</td>
<td></td>
</tr>
<tr>
<td>Software Update</td>
<td>For more information about the Software Update function, see &quot;Upgrading Software&quot; on pages 30–31.</td>
</tr>
<tr>
<td>Contact Samsung</td>
<td>Provides contact information for assistance with your player.</td>
</tr>
<tr>
<td>Reset</td>
<td>Resets all settings to their default settings except for the network and Smart Hub settings, and then launches the Setup function. The default security PIN is 0000.</td>
</tr>
</tbody>
</table>
When you connect this player to a network, you can use network based applications and functions such as Smart Hub and BD-LIVE, and upgrade the player’s software through the network connection. For more information about accessing and using Internet services, see the Network Services chapter of this manual on pages 44–55. Instructions for configuring the network connection start below.

Configuring Your Network Connection

Before you begin, contact your ISP to find out if your IP address is static or dynamic. If it is dynamic, and you have a wired or wireless network, we recommend using the Automatic configuration procedures described below.

If you are connecting to a wired network, connect the player to your router using a LAN cable before you start the configuration procedure.

If you are connecting to a wireless network, disconnect any wired network connection before you begin.

To begin configuring your network connection, follow these steps:

Wired Network

1. In the Home screen, select Settings, and then press the v button.
2. Select Network, and then press the v button.
3. Select Network Settings, and then press the v button.
4. Select Wired in the Network Settings screen, and then press the v button.
5. Select Connect button, and then press the v button. The product detects the wired connection, verifies the network connection and then connects to the network.

Wired - Manual

If you have a static IP address or the Automatic procedure does not work, you’ll need to set the Network Settings values manually.

Follow Steps 1 and 2 in Wired Network, and then follow these steps:

1. Select Network Status. The player searches for a network, and then displays the connection failed message.
2. On the bottom of the screen, select IP Settings, and then press the button. The IP Settings screen appears.
3. Select the IP Setting field, and then press the button.
4. Select Enter manually in the IP Setting field, and then press the button.
5. Select a value to enter (IP Address, for example), and then press the button. Use the number keypad on your remote control to enter the numbers for the value. You can also enter numbers using the ▲▼ buttons. Use the ◄► buttons on the remote control to move from entry field to entry field within a value. When done with one value, press the v button.
6. Press the ▲ or ▼ button to move to another value, and then enter the numbers for that value following the instructions in Step 5.
7. Repeat Steps 5 and 6 until you have filled in all values.

| NOTES |

You can get the Network values from your Internet provider.

8. When finished entering all the values, select OK, and then press the button. The player verifies the network connection and then connects to the network.
Wireless Network
You can setup a wireless network connection in four ways:
- Wireless Automatic
- Wireless Manual
- WPS(PBC)
- WPS(PIN)
When you configure the wireless network connection, any wireless network devices currently connected through the player or, if applicable, the player’s current wired connection, will be disconnected.

Wireless - Automatic
1. In the Home screen, select Settings, and then press the button.
2. Select Network, and then press the button.
3. Select Network Settings, and then press the button.
4. Select Wireless in the Network Settings screen, and then press the button. The player searches for and then displays a list of the available networks.
5. Select the desired network, and then press the button.
6. On the Security screen, enter your network’s Security Code or Pass Phrase. Enter numbers directly using the number buttons on your remote control. Enter letters by selecting a letter with an arrow button, and then pressing button.

<table>
<thead>
<tr>
<th>NOTES</th>
</tr>
</thead>
</table>
| To view the password as you enter it, use the arrow buttons to select Show Password on the right side, and then press button.

Wireless - Manual
If you have a static IP address or the Automatic procedure does not work, you’ll need to set the Network Settings values manually.

1. Follow the directions in Wireless - Automatic through Step 5.
2. The player searches for a network, and then displays the connection failed message.
3. On the bottom of the screen, select IP Settings, and then press the button. The IP Settings screen appears.
4. Select the IP Setting field, and then press the button.
5. Select Enter manually in the IP Setting field, and then press the button.
6. Select a value to enter (IP Address, for example), and then press button. Use the number keypad on your remote control to enter the numbers for the value. You can also enter numbers using the buttons. Use the buttons on the remote control to move from entry field to entry field within a value. When done with one value, press the button.

7. Press the ▲ or ▼ button to move to another value, and then enter the numbers for that value following the instructions in Step 6.

8. Repeat Steps 6 and 7 until you have filled in all values.

**NOTES**
- You can get the Network values from your Internet provider.

9. When finished, select OK, and then press the button. The Security Screen appears.

10. On the Security screen, enter your network’s Security Code or Pass Phrase. Enter numbers directly using the number buttons on your remote control. Enter letters by selecting a letter with the buttons, and then pressing the button.

11. When finished, select Done at the right of the screen, and then press the button. The player verifies the network connection and then connects to the network.

12. After the player verifies the network, select OK, and then press the button.

**WPS(PBC)**

1. In the Home screen, select Settings, and then press the button.

2. Select Network, and then press the button.

3. Select Network Settings, and then press the button.

4. Select Wireless in the Network Settings screen, and then press the button.

5. Press the ▲ button on your remote, and then press the ▶ button to select the WPS(PBC).

6. Press the button on your remote. The "Press the PBC button" message appears.

7. Press the WPS(PBC) button on your router within two minutes. Your player automatically acquires all the network settings values it needs and connects to your network. The Network Status screen appears. The player connects to the network after the network connection is verified.

**WPS(PIN)**

Before you begin, open the router’s setup menu on your PC and access the screen with the WPS PIN entry field.

1. In the Home screen, select Settings, and then press the button.

2. Select Network, and then press the button.

3. Select Network Settings, and then press the button.

4. Select Wireless in the Network Settings screen, and then press the button. The player searches for and then displays a list of the available networks.

5. Select the desired network, and then press the button.

6. Select the WPS(PIN), and then press the button. The PIN pop-up appears.

7. Enter the PIN into the WPS PIN entry field in the router’s Set Up screen and then save the screen.

**NOTES**
- Contact the manufacturer of the router for instructions explaining how to access the route’s Set Up screens or refer to the router’s user’s manual.
- For WPS connection, set your wireless router’s security encryption to AES. Setting to WEP security encryption does not support WPS connection.
Wi-Fi Direct

The Wi-Fi Direct function allows you to connect Wi-Fi Direct devices to the player and each other using a peer-to-peer network, without a wireless router.

| NOTES |

- Some Wi-Fi Direct devices may not support the AllShare function if connected via Wi-Fi Direct. If this is the case, it is advisable to change the network connection method between devices.
- Bluetooth transmissions can interfere with the Wi-Fi Direct signal. Before you use the Wi-Fi Direct function, we strongly recommend that you turn off the Bluetooth function of any active mobile device.

1. Turn on the Wi-Fi direct device and activate its Wi-Fi Direct function.
2. In the Home screen, select Settings, and then press the button.
3. Select Network, and then press the button.
4. Select Wi-Fi Direct, and then press the button.

   The Wi-Fi Direct devices that you can connect appear.

5. You have three ways to complete the Wi-Fi connection:
   - Through the Wi-Fi device.
   - Through the player using PBC.
   - Through the player using a PIN.
   Each is covered below.

Through the Wi-Fi Device

1. On the Wi-Fi device, follow the procedure on the device for connecting to another Wi-Fi Direct device. See the device’s user manual for instructions.

2. When you have completed the procedure, you should see a pop-up on your TV screen saying that a device that supports Wi-Fi Direct has requested to connect. Select OK, and then press the button to accept.

3. The Connecting pop-up appears, followed by the Connected pop-up. When it closes, you should see the device listed on the Wi-Fi Direct screen as connected.

Through the Player Using PBC

1. Select the Wi-Fi Direct device you want to connect to this player, and then press the button. The PBC/PIN pop up appears.
2. Select PBC, and then press the button. The PBC pop-up appears.
3. Press the PBC button on the Wi-Fi Direct device within 2 minutes.
4. The Connecting pop-up appears, followed by the Connected pop-up. When it closes, you should see the device listed on the Wi-Fi Direct screen as connected.

Through the Player Using a PIN

1. Select the Wi-Fi Direct device you want to connect to this player, and then press the button. The PBC/PIN pop up appears.
2. Select PIN, and then press the button. The PIN pop-up appears.
3. Note the PIN code in the pop-up, and then enter it into the appropriate field in the Wi-Fi Direct device you want to connect.
4. The Connecting pop-up appears, followed by the Connected pop-up. When it closes, you should see the device listed on the Wi-Fi Direct screen as connected.

| NOTES |

- The current wired or wireless network connection will be disconnected when you use the Wi-Fi Direct function.
- Text files, such as files with a .TXT or .DOC extension, will not display when you are using the Wi-Fi Direct function.
Settings

**Upgrading Software**

The Software Update menu allows you to upgrade the player’s software for performance improvements or additional services.

- Never turn the player off or back on manually during the update process.

1. In the Home screen, select the **Settings**, and then press the `v` button.
2. Select **Support**, and then press the `v` button.
3. Select **Software Update**, and then press the `v` button.
4. To download update software and update now, select **Update Now**, and then press the `v` button. See Update Now on this page for details.
5. To let the product download update software automatically when available, select **Auto Update**, and then press the `v` button. See Auto Update on page 31 for details.

<table>
<thead>
<tr>
<th>NOTES</th>
</tr>
</thead>
</table>
| - The upgrade is complete when the player turns off, and then turns on again by itself.  
- Samsung Electronics shall takes no legal responsibility for player malfunction caused by an unstable Internet connection or consumer negligence during a software Update.  
- If you want to cancel the upgrade while the upgrade software is downloading, press the `v` button.  
- When a system upgrade is in progress, "UPDATE" is displayed on the front panel. |

**Update Now**

You can use Update Now to update the software through your network connection or by using a USB flash drive. The network instructions are below. The USB flash drive instructions are on the next page.

1. Select **Update Now**, and then press the `v` button.  
The Update now pop-up appears.
2. The product searches on line for the latest software version.
3. If it finds a new version, the Update Request pop-up appears.
4. Select **OK**. The product upgrades the software, turns off, and then turns on automatically.
5. If you do not select **OK** or **Cancel** in one minute, the product stores the new upgrade software. You can upgrade the software later using **Auto Update**.
6. If you select **Cancel**, the product cancels the upgrade.

<table>
<thead>
<tr>
<th>NOTES</th>
</tr>
</thead>
</table>
| - When the system upgrade is done, check the software details in the Product Information section of the Contact Samsung screen.  
- Do not turn off the player during the Software Update. It may cause the player to malfunction. |
Auto Update

You can set the Auto Update function so that the player downloads new upgrade software when it is in Auto Update mode. In Auto Update mode, the player is off, but its Internet connection is active. This allows the player to download upgrade software automatically, when you are not using it.

1. Press the ▲▼ buttons to select Auto Update, and then press the button.

2. Select On or Off. If you select On, the player will automatically download new upgrade software when it is in Auto Update mode with the power off. If it downloads new upgrade software, the player will ask you if you want to install it when you turn the player on.

<table>
<thead>
<tr>
<th>NOTES</th>
</tr>
</thead>
</table>
| To use the Auto Update Mode Upgrade function, your player must be connected to the Internet.

< By USB >

2. Click SUPPORT on the top right of the page.
3. Enter the product’s model number into the search field. As you enter the model number, a drop down will display products that match the model number.
4. Left click your product’s model number in the drop down list.
5. On the page that appears, scroll down to and then click Firmware Manuals & Downloads.
6. Click Firmware in the center of the page.
7. Click the ZIP button in the File column on the right side of the page.
8. Click Send in the first pop-up that appears. Click OK in the second pop-up to download and save the firmware file to your PC.
9. Unzip the zip archive to your computer. You should have a single folder with the same name as the zip file.
10. Copy the folder to a USB flash drive.
11. Make sure no disc is inserted in the product, and then insert the USB flash drive into the USB port of the product.
12. In the product’s menu, go to Settings > Support > Software Update.
13. Select Update Now.
14. The product searches for the software on the USB drive. When it finds the software, the Update Request pop-up appears.
15. Select OK. The product upgrades the software, turns off, and then turns on automatically.

<table>
<thead>
<tr>
<th>NOTES</th>
</tr>
</thead>
</table>
| There should be no disc in the player when you upgrade the software using the USB jack.
| When the system upgrade is done, check the software details in the Product Information section of the Contact Samsung screen.
| Do not turn off the player during the Software Update. It may cause the player to malfunction.
| Software Updates using the USB jack must be performed with a USB flash memory stick only.
Your Blu-ray Disc Player can play content located on Blu-ray/DVD/CD discs, USB devices, PCs, smart phones, tablets, and on the Web. To play content located on your PC or on mobile devices, you must connect them and this product to your network. To play content on your PC, you must also install Allshare network software on your PC.

NOTES
- PCs running Windows 7 and Windows 8 have Allshare software (Play To) built in.

The AllShare Play Screen

For all media, the AllShare Play Main screen or one of its sub screens is your primary means of accessing and playing contents saved on a variety of devices, either connected directly or using your network.

Accessing the AllShare Play Screen

To access the AllShare Play Main screen, select Photos, Videos & Music on the Home screen, and then press the button.

Playing Commercial Discs

1. Press the button to open the disc tray.
2. Place a disc gently into the disc tray with the disc's label facing up.
3. Press the button to close the disc tray. Playback starts automatically.
4. If playback does not start automatically, press the button on the remote control.

Playing Files on a USB Device

There are two methods you can use to play or view multimedia files located on a USB device through your player.

Method 1

1. Turn the player on.
2. Connect the USB device to the USB port on the front panel of the player. The New Device Connected pop-up appears.
3. Use the buttons to select Photos, Videos, Music or All Content, and then press the button. The AllShare Play screen appears listing the content of the device. Depending on how the contents is arranged, you will see either folders, individual files, or both.

NOTES
- If the pop-up does not appear, go to Method 2.
I NOTES I

- Even though the player will display folders for all content types, it will only display files of the Content Type you selected in Step 2. For example, if you selected music, you will only be able to see music files. You can change this selection by returning to the All Share Play screen and going to Step 4 in Method 2 below.

4. If necessary, use the the ▲▼◄► buttons to select a folder, and then press the button.

5. Select a file to view or play, and then press the button.

6. Press the RETURN button to exit a folder or the EXIT button to return to the Home screen.

7. Go to pages 36–43 for instructions that explain how to control playback of videos, music, and pictures on a USB device.

I NOTES I

- Even though the player will display folders for all content types, it will only display files of the Content Type you selected in Step 2. For example, if you selected music, you will only be able to see music files. You can change this selection by returning to the All Share Play screen and repeating Step 4.

Method 2

1. Turn the player on.

2. Connect the USB device to the USB port on the front panel of the player.

3. Select Photos, Videos & Music on the Home screen, and then press the button.

4. Select Photos, Videos, Music or All Content, and then press the button.

I NOTES I

- Even though the player will display folders for all content types, it will only display files of the Content Type you selected in Step 2. For example, if you selected music, you will only be able to see music files. You can change this selection by returning to the All Share Play screen and repeating Step 4.

5. Use the ◄► buttons to select the desired device and then press the button. Depending on how the contents are arranged, you will see either folders, individual files, or both.

6. If necessary, use the ▲▼◄► buttons to select a folder, and then press the button.

7. Use the ▲▼◄► buttons to select a file to view or play, and then press the button.

8. Press the RETURN button to exit a folder or the EXIT button to return to the Home screen.

9. Go to pages 36–43 for instructions that explain how to control playback of videos, music, and pictures on a USB device.

I NOTES I

- If you insert a disc when playing a USB device, the device mode changes to "Disc" automatically.

Playing a Disc with User Recorded Content

You can play multimedia files you have recorded on Blu-ray, DVD, or CD discs.

1. Place a user recorded disc into the disc tray with the disc’s label facing up, and then close the tray. The Device Connected pop-up appears.

2. Use the ▲▼ buttons to select the type of content you want to view or play - Photos, Videos, Music, or All Content - and then press the button.

I NOTES I

- Even though the player will display folders for all content types, it will only display files of the Content Type you selected in Step 2. For example, if you selected music, you will only be able to see music files. You can change this selection by returning to the All Share Play screen and repeating Step 2.

3. A screen appears listing the contents of the disc. Depending on how the contents are arranged, you will see either folders, individual files, or both.
4. If necessary, use the ▲▼◄► buttons to select a folder, and then press the ◄ button.
5. Use the ◄►▲▼ buttons to select a file to view or play, and then press the ◄ button.
6. Press the RETURN button one or more times to exit a current screen, exit a folder, or to return to the Home screen. Press the EXIT button to return directly to the Home Screen.
7. Go to pages 36–43 for instructions that explain how to control playback of videos, music, and pictures on a disc.

### Using the Allshare Network Function

Allshare software lets you play Photos, Videos, or Music located on your PC or your Allshare compatible device through the player using a wireless connection.

#### To Download the Allshare Software

If your PC is not running Windows 7 or 8, you must install Allshare software on your PC to use the Allshare function. You can download the Allshare software and get detailed instructions for using the Allshare software from the Samsung.com website.

2. Click Support at the top of the page.
3. On the Support page, enter the model number of your player into the Model Number field, and then press the ◄ button.
4. On the page that appears, click See All Downloads on the left side of the screen under Downloads. The Download Tab appears.

5. On the Download Tab, click Software.
6. In the list of software, click the EXE button on the right side of the Allshare software line.
7. In the pop-up that appears, click the Send button.
8. In the next pop-up, click Save File.
9. Find the Allshare install file on your disk, and then double click the file.
10. In the pop-up that appears, click Run, and then follow the directions that appear on your screen.

Download the Allshare software Installation/Instruction manual from the same Software Tab by clicking the corresponding PDF file symbol in the File column on the right. The file, in PDF format, will download and open. You can view and/or save the file.
Playing Content Located on Your PC or Allshare Device through the Blu-ray Disc Player

1. Connect the Blu-ray Disc Player, your PC, and/or your Allshare compatible device to the same wireless network.

2. Follow the directions in the Allshare software Installation/Instruction manual to set up devices and files for playing or viewing.

3. Select Photos, Videos & Music on the player’s Home screen, and then press the button. The AllShare Play screen appears.

4. Select the type of content you want to play - Photos, Videos, Music, or All Content - and then press the button.

5. On the next screen, select Allshare, and then press the button.

6. In the list of Allshare connected devices that appears, select your PC or other Allshare compatible device, and then press the button. A screen listing the available files appears.

7. Select the file you want to play or view, and then press the button.

Controlling the Playback of Content Located on Your PC with Your Smart Phone

(Only available with Samsung phones supporting Allshare functionality.)

1. Connect the Blu-ray Disc Player, your PC, and your Allshare compatible cellular phone to the same wireless network.

2. Follow the directions in the Allshare software Installation/Instruction manual to set up devices and files for playing or viewing.

3. On your computer, using the Allshare software, confirm your phone is connected.

4. On the phone, select the file you want to view or play, and then select the Blu-ray player as the playback device.

5. On the phone, start playback.
Controlling Video Playback

You can control the playback of video content located on a Blu-ray/DVD disc, USB, mobile device or PC. Depending on the disc or contents, some of the functions described in this manual may not be available.

Buttons on the Remote Control used for Video Playback

<table>
<thead>
<tr>
<th>Buttons on the Remote Control</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DISC MENU button</td>
<td>During playback, press this button to display the Disc menu.</td>
</tr>
<tr>
<td>TITLE MENU button</td>
<td>During playback, press this button to display the Title menu.</td>
</tr>
<tr>
<td>POPUP MENU button</td>
<td>During playback, press this button to display the Popup menu.</td>
</tr>
</tbody>
</table>

Using the Tools Menu

During playback or in pause mode, press the TOOLS button.

<table>
<thead>
<tr>
<th>Play from the Beginning</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select to return to the beginning of the movie, and then press the button.</td>
<td></td>
</tr>
</tbody>
</table>

3D

Use 3D menu to select Side by Side or Top and Bottom option if the 3D content currently playing does not properly appear in 3D mode.

**NOTES**

- Use 3D menu for 3D contents only.
- If applied to 2D contents, it may not be displayed properly.

Movie Note

**Movie Note** provides information such as director, cast, synopsis, etc.

**NOTES**

- This function is available if the disc includes Movie Note information and the player is connected to a network.

Search Scene

You can use the Search Scene function during playback to view or start a movie from the scene of your choice.
### Search Scene

<table>
<thead>
<tr>
<th>NOTES</th>
</tr>
</thead>
<tbody>
<tr>
<td>- If the index information in the file is damaged or the file does not support indexing, you will not be able to use the Search Scene function.</td>
</tr>
<tr>
<td>- If you are using the Allshare function after connecting to a computer through your network, <strong>Search Scene</strong> may not be supported.</td>
</tr>
</tbody>
</table>

### Search Titles

If there is more than one movie on the disc or device, select to start a different title.

1. Select **Search Titles**, and then press the \( \square \) button.
2. Use the \( \uparrow \downarrow \) buttons to select a title, and then press the \( \square \) button.

### Search Chapters

Select to play the chapter of your choice.

1. Select **Search Chapters**, and then press the \( \square \) button.
2. Use the \( \uparrow \downarrow \) buttons to select a chapter, and then press the \( \square \) button.

### Search Time Bar

Select to play the movie from a selected time point.

1. Select **Search Time Bar**, and then press the \( \square \) button.
2. Using the number buttons, enter the time point you want to go to, and then press the \( \square \) button.

<table>
<thead>
<tr>
<th>NOTES</th>
</tr>
</thead>
<tbody>
<tr>
<td>- You can also use the ( \leftarrow \rightarrow ) buttons to advance or rewind the movie. The movie advances or rewinds one minute each time you press the ( \leftarrow \rightarrow ) buttons.</td>
</tr>
</tbody>
</table>

### Repeat Mode

Select to repeat a title, chapter, or specific section.

- **Off** : Select to return to normal playback.
- **Title** : Choose to repeat a selected title.
- **Chapter** : Choose to repeat a specific chapter.
- **Repeat A-B** : Choose to repeat a specific section.

1. Press the \( \uparrow \downarrow \) buttons to select **Repeat A-B**, and then press the \( \square \) button.
2. Press the \( \square \) button at the point where you want repeat play to start (A). Let the movie play.
3. Press the \( \square \) button at the point where you want repeat play to stop (B).

<table>
<thead>
<tr>
<th>NOTES</th>
</tr>
</thead>
<tbody>
<tr>
<td>- You must set point (B) at least 5 seconds of playing time after point (A).</td>
</tr>
</tbody>
</table>

### Picture Mode

Select to set the picture mode.

- **Dynamic** : Increases sharpness and brightness.
- **Standard** : Choose this setting for most viewing applications.
- **Movie** : The best setting for watching movies.
- **User** : Lets you adjust the sharpness and noise reduction function respectively.

<table>
<thead>
<tr>
<th>NOTES</th>
</tr>
</thead>
<tbody>
<tr>
<td>- When you use the BD wise function, this menu will not appear.</td>
</tr>
</tbody>
</table>

### Audio

Select to set the desired audio language.
Media Play

Subtitle
Select to set the desired subtitle language.
- You can also operate this function by pressing the SUBTITLE button on the remote control.

Subtitle Settings
Select to set the desired subtitle options.

Angle
Select to view a scene from another angle. The Angle option displays the number of angles available to view. When a Blu-ray Disc/DVD contains multiple angles of a particular scene, you can change angle.

BONUSVIEW Video
Select to set the desired bonusview option.

BONUSVIEW Audio

Full screen
Select to set the size of the video image. Choose Original, Mode 1 (larger), or Mode 2 (largest).

Information
Select to view video file information.

Title
Displays all the video files on the media or storage device by title.

Date
Displays all the folders with videos by date. If you select a folder, and then press the □ button, displays all the videos in the folder by date.

Folder
Displays all the folders on the media or storage device.

Playlist
Displays available play lists.

Title List
Displays all the video files on the media or storage device by title. Alternate to Title.

NOTES
Depending on the disc or storage device, the Tools menu may differ or not be shown.

Video files with high bitrates of 20Mbps or more strain the player's capabilities and may stop playing during playback.

Using the View & Options Menus

Using the View Menu
On the video file playback screen, use the the ▲▼◄► buttons to select View and then press the □ button.

Using the Options Menu
On the video file playback screen, use the the ▲▼◄► buttons to select Options and then press the □ button.

NOTES
Depending on the disc or storage device, the Options menu may differ or not be shown.

Play Selected
Lets you create a playlist by selecting specific files to play. It works essentially the same way for all media. See Creating a Playlist on an Audio CD on pages 40–41.

Send
Select to upload selected files to online sites (Picasa, Facebook etc) or a device. To use this function, you need to establish an account with the online site, and then log in using the Log In function.

Delete
Select to delete a file from a device.
**Controlling Music Playback**

You can control the playback of music content located on a DVD, CD, USB, mobile device or PC. Depending on the disc or contents, some of the functions described in this manual may not be available.

**Buttons on the Remote Control used for Music Playback**

1. **NUMBER buttons**: If numbered tracks are displayed, press the number of a track. The selected track is played.
2. **button**: Moves to the previous/next track.
3. **button**: Stops a track.
4. **Fast Play (Audio CD (CD-DA) only)**
   - During playback, press the or button. Each time you press the or button, the playback speed will change.
5. **button**: Pauses a track.
6. **button**: Plays the currently selected track.

**Using the View & Options Menus**

### Using the View Menu

On the music file playback screen, use the the buttons to select View, and then press the button.

<table>
<thead>
<tr>
<th>Track</th>
<th>Displays all the music tracks on the media or storage device.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Album</td>
<td>Displays all music on the media or storage device by album.</td>
</tr>
<tr>
<td>Artist</td>
<td>Displays all the music files on the media or storage device by artist.</td>
</tr>
<tr>
<td>Genre</td>
<td>Displays all the music on the media or storage device by genre.</td>
</tr>
<tr>
<td>Folder</td>
<td>Displays all the folders on the media or storage device.</td>
</tr>
</tbody>
</table>

**NOTES**

- Depending on the disc or storage device, the View menu may differ or not be shown.

### Using the Options Menu

On the music file playback screen, use the the buttons to select Options and press the button.

<table>
<thead>
<tr>
<th>Play Selected</th>
<th>Lets you create a playlist by selecting specific files to play. It works essentially the same way for all media. See Creating a Playlist on an Audio CD on pages 40–41.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Send</td>
<td>Select to send selected files to other devices.</td>
</tr>
</tbody>
</table>
Ripping

The Ripping function converts CD audio to the mp3 format and saves the converted files on a USB device or the mobile device connected to the player. See Ripping on page 41.

Information

Select to see the (Contents) information.

Encoding

Select to manage the text encoding options.

Delete

Select to delete a file from the device.

### Repeating Tracks on an Audio CD

You can set the product to repeat tracks on an audio CD (CD-DA/MP3).

1. On the Playback screen, use the ▲▼◄► buttons to select 🎧 in the lower left corner of the screen, and then press the 🎧 button.
2. Use the ▲▼ to select the repeat mode you want - Off, One Song, or All - and then press the 🎧 button.

### Shuffling Tracks on an Audio CD

You can set the product to play tracks on an audio CD (CD-DA/MP3) at random.

1. On the Playback screen, use the ▲▼◄► buttons to select 🎧 in the lower left corner of the screen, and then press the 🎧 button.
2. Use the ▲▼ to set the Shuffle mode On or Off, and then press the 🎧 button.

### Creating a Playlist from an Audio CD

1. With the Playback screen displayed, select the Options button, and then press the 🎧 button. The Options menu appears.
2. Use the ▲▼ buttons to select Play Selected, and then press the 🎧 button. The Selection Play screen appears.
3. Use the ▲▼ buttons to select a track, and then press the 🎧 button. A check appears to the left of the track.
4. Repeat Step 3 to select and check additional tracks.
5. To remove a track from the list, move to the track, and then press the 🎧 button again. The check on the track is removed.
6. When done, press the ▲▼ button to select Play, and then press the 🎧 button. The Music Playback screen reappears listing only the tracks you checked. The selected tracks play automatically.

### NOTES

- You can create a playlist with up to 99 tracks on Audio CDs (CD-DA).
- If you have created a playlist, Play Selected is replaced by Edit Playlist on the Options menu.
- On the Selection Play screen, you can also choose Select All, Clear All, and Cancel.
- Use **Select All** to select all tracks. This cancels your individual track selections. When you press the **RETURN** button on your remote control or select the **Play** button, all tracks will appear on the Music Playback screen, and the product will begin to play all tracks from Track 001.

- Use **Clear All** to deselect all selected tracks at once. Then, select individual tracks or use **Select All** to select all the tracks, and then press the **RETURN** button on your remote control. If you do not use **Select All** or select individual tracks, the Playlist will not change.

- **Cancel** cancels any changes you made on the Play Select screen. When you return to the Playback screen, the Playlist will be unchanged.

**Ripping**

1. Insert a USB device into the USB jack on the front of the product.
2. With the Playback screen displayed, select the **Options** and then press the **v** button. The Options menu appears.
3. Use the ▲▼ buttons to select **Ripping**, and then press the **v** button. The Ripping screen appears.
4. Use the ▲▼ buttons to select a track, and then press the **v** button. A check appears to the left of the track.
5. Repeat Step 4 to select and check additional tracks.
6. To remove a track from the list, move to the track, and then press the **v** button. The check on the track is removed.
7. When done, select the **Rip** button using the ▲▼ buttons, and then press the **v** button. The Rip pop-up appears.
8. Use the ▲▼ buttons to select the device to store the ripped files to, and then press the **v** button.

**I NOTES**

- Do not disconnect the device while ripping is in progress.

- If you want to cancel ripping, press the **v** button and then select Yes. Select No to continue ripping.

- When ripping is complete, the “Successfully Ripped.” message appears. Press the **v** button.

- Press the **RETURN** button or select **Cancel**, and then press the **v** button to go back to the Playback screen.

**I NOTES**

- This function is not available with DTS Audio CD.
- This function may not be supported by some discs.
- Ripping encodes music to the .mp3 format at 192kbps.
- On the Ripping screen, you can also choose **Select All** and **Clear All**.
  - Use **Select All** to select all tracks and press the **v** button. This cancels your individual track selections.
  - Use **Clear All** to deselect all selected tracks at once.

**Playing Photo Contents**

You can play photo contents located on a DVD, USB, mobile device or PC.

**Using the Tools Menu**

During playback, press the **TOOLS** button. A series of icons appears at the bottom of the screen. The icons, which are shown from left to right on the screen, are shown in the same order, from top to bottom, in the table below.

<table>
<thead>
<tr>
<th>Previous</th>
<th>Select to move to the previous picture.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Next</td>
<td>Select to move to the next picture.</td>
</tr>
<tr>
<td>Start / Stop Slide Show</td>
<td>Select to play/pause the slide show.</td>
</tr>
</tbody>
</table>
Slide Show Settings

Select the Slide Show settings.

Zoom
Select to enlarge the current picture. (Enlarge up to 4 times)

Rotate
Select to rotate the picture. (This will rotate the picture either clockwise or counter clockwise.)

Background Music
Select to listen to music while viewing a slide show.

Settings
Select the picture mode - Dynamic, Standard, Movie, or User - or display information about the current picture.

I NOTES I

Depending on the disc or storage device, the Tools menu may differ or not be shown.

To enable the background music function, the photo file must be in the same storage media as the music file. However, the sound quality can be affected by the bitrate of the MP3 file, the size of the photo, and the encoding method.

You can’t enlarge the subtitle and PG graphic in the full screen mode.

Using the View & Options Menus

Using the View Menu

On a file screen containing photo files, select the View and press the button.

<table>
<thead>
<tr>
<th>Title</th>
<th>Displays all the photo files on the media or storage device by title.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Date</td>
<td>Groups all the photo files on the media or storage device by date. Click a group to see the photos in that group.</td>
</tr>
<tr>
<td>Folder</td>
<td>Displays all the folders on the media or storage device.</td>
</tr>
</tbody>
</table>

I NOTES I

Depending on the disc or storage device, the View menu may differ or not be shown.

Using the Options Menu

On a file screen containing photo files, select the Options and press the button.

| Slide show | Starts the slide show. Shows all the files in the current folder, one after another. If you want to create a slide show with a selected group of photos, see Play Selected below. |
| Play Selected | Lets you create a playlist by selecting specific photos to see. It works essentially the same for all media. See Creating a Playlist from an Audio CD on pages 40–41 for instructions. |
| Send | Select to upload selected files to an on-line site (Picasa, Facebook etc) or a device. To use this function, you need to establish an account with the on-line site, and then log in using the Log In function. See Using the Send Function on page 43. |
| Delete | Select to delete the a file from the device. |

I NOTES I

Depending on the disc or storage device, the Options menu may differ or not be shown.
Using the Send Function

You can upload files to an on-line site (Picasa, Facebook etc) or a device.

1. With the Photo Playback screen displayed, select the **Options** button, and then press the [ ] button. The Options menu appears.

2. Use the ▲▼ buttons to select **Send**, and then press the [ ] button. The Selection screen appears.

3. Use the ▲▼ buttons to select a picture, and then press the [ ] button. A check appears to the left of the picture.

4. Repeat Step 3 to select and check additional pictures.

5. To remove a picture from the list, move to the picture, and then press the [ ] button again. The check on the picture is removed.

6. When done, press the ▲▼ button to select **Send**, and then press the [ ] button. The Send pop-up appears listing the on-line sites (Picassa, Facebook, etc.) or devices that you can send the photos to.

7. Select a destination, and then press the [ ] button.

8. If you are sending the photos to an on-line site, the site starts. Log in and follow the directions on the screen.

| NOTES |

- To send photos to an on-line site you must have an account with that site.
Network Services

You can enjoy various network services such as streaming video or on-line apps by connecting the player to your network.

To use network services, you must first:
1. Connect the player to the network. (See page 17)
2. Configure the network settings. (See pages 26–29)

Logging In to Your Samsung Account

Before you access Movies & TV Shows or Apps, we suggest you log in to your Samsung account.

I NOTES
- If you do not have a Samsung account, follow the directions in the Quick Startup Guide to create one.

To log in to your Samsung account, follow these steps:
1. With the Home screen displayed, press the RED (A) button. The Log In screen appears.
2. Select the Email field, and then press the button. The keyboard pop-up appears.
3. Using the keyboard, enter your e-mail address. When finished, select the Done button, and then press the button. The Log In screen re-appears.
4. Select the Password field, and then press the button. The keyboard pop-up appears.
5. Using the keyboard, enter your password. When finished, select the Done button, and then press the button. The Log In screen re-appears.
6. To make the log in process easier next time, select Sign me in automatically, and then press the button.
7. Select Log In, and then press the button. The player logs you in to your account. Your account e-mail is displayed on the bottom left of the screen.

I NOTES
- If you selected Sign me in automatically, the next time you log in, the player will automatically enter your e-mail and password. All you need to do is select Log In.
- If your e-mail address and password are not displayed when the Log In screen appears, select the button with the down pointing arrow head next to the Email field, and then press the button. A drop down list of all your registered accounts will appear. Select your account, and then press the button. The player will fill in the e-mail and password fields.
- If you press the RED (A) button after you have logged in, the My Account pop-up appears. On the pop-up, you can select Logout, Change Account Information, Link Service Accounts, Remove Accounts from the Device, and Deactivate Account.
- To rent movies and purchase for-pay apps, you must have a credit card registered in your account. If you haven’t registered a card, select Change Account Information. On the Change Account information page, select Register Card, press the button, and then follow the directions on the screen.

Before Using Movies & TV Shows or Apps

If you haven’t set up Smart Hub, when you use Movies & TV Show or Apps for the first time, the player will ask you to perform the Smart Hub set up procedure.
1. On the Home screen, select either Movies & TV Shows or Apps, and then press the \button. If you have selected Apps, go to Step 4.

2. If you selected Movies & TV Shows, the Smart Hub pop-up appears asking if you want to set up Smart Hub. Select Yes, and then press the \button. The Welcome screen appears.

3. Select Start, and then press the \button. The Smart Hub Terms & Conditions, Privacy Policy screen appears.

4. On the Smart Hub Terms & Conditions, Privacy Policy screen, you must review and agree to both the Smart Hub Terms and Conditions and the Privacy Policy to use Smart Hub.

5. Scroll down, and then click the View Details buttons to review the full documents.

6. When done reading, scroll up to the first entry field, and press the \button to agree to the Terms and Conditions and consent to the Privacy Policy.

7. Press the ► button twice to go to the Supplemental Privacy Notices screen.

8. Click the View Details button to view the entire notice.

9. When done reading, scroll up to the top entry field, and then press the \button.

| NOTES |

\>
You do not need to consent to the Supplemental Privacy Notice, but one or more Smart TV features or functionalities may not be available if you do not.

10. Press the ► button twice. The Setup Complete screen appears. Press the \button.

### Using Movies & TV Shows

You can download or stream for pay and free-of-charge movies and TV shows and view them on your TV.

1. On the Home screen, select Movies & TV Shows, and then press the \button.

2. Select one of the Featured or Recommended movies, and then press the \button. The page for that movie appears.

   OR

Use the \button to go to the bottom of the screen. Select Favorites, Featured, TV Shows, Movies, or Purchased, and then press the \button.

On the page that appears, use the \\ buttons to select a show or movie, and then press the \button.

On the TV Shows or Movies screen, you can also select What’s New, Most Popular, or Genres to see more available shows or movies. On the Genre screen, use the \\ buttons to select a Genre, and then press the \button.

To make a selection on a page displaying TV shows or movies, use the \\ buttons to make a selection, and then press the \button.
Network Services

3. To watch a selection, select Watch now, and then press the \( \text{\textasciitilde} \) button. A selection screen appears listing various locations from which you can rent the film along with prices.

4. Select a location, and then press the \( \text{\textasciitilde} \) button. Follow the directions on the screen to start the movie.

<table>
<thead>
<tr>
<th>NOTES</th>
</tr>
</thead>
<tbody>
<tr>
<td>- If you haven’t logged into your Samsung account, the Log In screen will appear after Step 3 and you will need to log in.</td>
</tr>
<tr>
<td>- If you don’t have a credit card associated with your Samsung account, after you log in, the Register Card screen will appear. Follow the directions on the screen. You must have a credit card registered to your account to rent movies and to purchase for-pay apps.</td>
</tr>
</tbody>
</table>

Using Apps

You can download applications from the Internet, and access various for pay or free-of-charge application and view them on your TV. To access some applications, you need to have a Samsung account.

The Apps Screen at a Glance

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Recommended : Displays recommended contents managed by Samsung.</td>
</tr>
<tr>
<td>2</td>
<td>My Apps : Displays your personal gallery of applications modifiable on the Downloaded screen.</td>
</tr>
<tr>
<td>3</td>
<td>Downloaded : Select to access the Downloaded screen where you can add to, modify, and delete applications and see all downloaded applications.</td>
</tr>
<tr>
<td>4</td>
<td>Featured Applications : Use the ( \text{\textasciitilde}\text{\textasciitilde}\text{\textasciitilde}\text{\textasciitilde} ) buttons to highlight the displayed Feature Application, and then press the ( \text{\textasciitilde} ) button. Information about the featured application appears.</td>
</tr>
</tbody>
</table>

Downloading Applications

You can download for pay or free-of-charge applications through Samsung Apps.

1. On the Apps screen, select Samsung Apps, and then press the \( \text{\textasciitilde} \) button. The Samsung Apps screen appears.

2. Across the top of the screen, under What’s New, you’ll see a series of new apps. Use the \( \text{\textasciitilde}\text{\textasciitilde}\text{\textasciitilde}\text{\textasciitilde} \) buttons to scroll the list right or left, and then select an app. Press the \( \text{\textasciitilde} \) button to see more information about the app. If the app is free, select Download, and then press the \( \text{\textasciitilde} \) button to download the app. If it is a for pay app, select Buy, press the \( \text{\textasciitilde} \) button, and then follow the instructions on the screen.

<table>
<thead>
<tr>
<th>NOTES</th>
</tr>
</thead>
<tbody>
<tr>
<td>- To buy an app, you must be logged into your Samsung account and have a credit card registered to the account. Press the ( \text{\textasciitilde} ) button on your remote to log in.</td>
</tr>
<tr>
<td>- If you haven’t registered a card, after you log in, press the ( \text{\textasciitilde} ) button again, and then select Change Account Information in the pop-up that appears. On the Change Account information page, select Register Card, press the ( \text{\textasciitilde} ) button, and then follow the directions on the screen.</td>
</tr>
<tr>
<td>- You can also access and download apps from the categories listed on the left of the screen. For instructions, see Step 4.</td>
</tr>
</tbody>
</table>
3. After the app has downloaded, select Run, and then press the ▼ button to run the app now. To run the app later, press the RETURN button. In either case, the icon for the app will appear on the Apps screen.

4. To see additional apps, use the ▲▼◄► buttons to move to the category list on the left side of the screen.

5. Use the ▲▼ buttons to select a category. Each time you move the highlight to another category, a different set of applications appears on the right.

6. Use the ► button to move to the applications and the ▲▼◄► buttons to move from app to app.

7. To see more information about an app, select it, and then press the ▼ button.

8. To download the app, follow the directions in Steps 2 and 3.

Starting an Application

1. Select Apps on the Home screen, and then press the ▼ button.

2. On the Apps screen, use the ▲▼◄► buttons to select an app, and then press the ▼ button. The app starts.

Using the Downloaded Screen

The Downloaded Screen lists all the apps you have downloaded and lets you:

- Sort the apps on the Downloaded screen by Date downloaded, Recently opened, and Title.
- Apply a number of Edit Menu functions to the apps listed in the My Apps section of the Apps screen including updating apps, moving apps into a folder, deleting the apps from My Apps, and locking the apps.
- Start apps.

Sorting the Apps

To sort the apps on the Download screen, follow these steps:

1. On the Home screen, select Apps, and then press the ▼ button.

2. On the Apps screen, use the ▼ button to move to the Downloaded hotspot at the bottom of the page, and then press the ▼ button.

3. On the Downloaded screen, use the ▲► buttons to move to View at the top of the screen, and then press the ▼ button.

4. In the drop down that appears, select Date Downloaded, Recently Opened, or Title, and then press the ▼ button. The apps on the Downloaded screen are sorted by the criteria you have chosen.

Using the Edit Menu Functions

Lock/Unlock

Using the Lock/Unlock function and the Security PIN, you can lock applications so they cannot be started on either the Apps screen or the Downloaded screen. The default PIN is 0000.

1. On the Downloaded screen, use the ▲► buttons to go to Edit at the top of the screen, and then press the ▼ button.
2. Select Lock/Unlock, and then press the \[\text{\textcolor{#483DFA}{
\textbullet}}\] button.

3. When the Lock Service appears, enter the PIN using the number buttons on your remote control.

4. To lock an application, select the application, and then press the \[\text{\textcolor{#483DFA}{
\textbullet}}\] button. A lock appears on the app. Repeat to lock other, individual apps.

5. To unlock a locked app, select the application, and then press the \[\text{\textcolor{#483DFA}{
\textbullet}}\] button.

6. To lock all the apps at once, use the \[\text{\textcolor{#483DFA}{
\textbullet}}\ \text{\textcolor{#483DFA}{\textbullet}}\] buttons to select the Lock All button, and then press the \[\text{\textcolor{#483DFA}{
\textbullet}}\] button.

7. To unlock all the locked apps at once, use the \[\text{\textcolor{#483DFA}{
\textbullet}}\ \text{\textcolor{#483DFA}{\textbullet}}\] buttons to select the Unlock All button and then press the \[\text{\textcolor{#483DFA}{
\textbullet}}\] button.

8. Press the RETURN button twice to return to the Apps screen. Locked apps will display a lock on the upper right side.

**Edit My Apps**

Edit My Apps lets you add apps to and delete apps from My Apps. It also lets you change the position of an app in My Apps.

**Add an App to My Apps**

1. On the Downloaded screen, use the \[\text{\textcolor{#483DFA}{
\textbullet}}\ \text{\textcolor{#483DFA}{\textbullet}}\] buttons to go to Edit at the top of the screen, and then press the \[\text{\textcolor{#483DFA}{
\textbullet}}\] button.

2. Select Edit My Apps, and then press the \[\text{\textcolor{#483DFA}{
\textbullet}}\] button. The Edit My Apps screen appears.

3. Select a full color app from the top row of apps, and then press the \[\text{\textcolor{#483DFA}{
\textbullet}}\] button. The full color app icon appears in the My Apps area below and the app icon in the top row is grayed out.

| NOTES |

- Grayed out apps are already in My Apps.
Create Folder

Create Folder lets you create a folder on the Downloaded screen into which you can put apps.

1. On the Downloaded screen, use the ▲► buttons to go to Edit at the top of the screen, and then press the ◄ button.
2. Select Create a Folder, and then press the ◄ button. The Set Folder Name pop-up appears.
3. Press the ◄ button. The keyboard appears.
4. Select the Clear button on the right side, and then press the ◄ button to remove Folder 1 from the entry field. Then, using the keyboard, enter the name you want to apply to the folder.
5. When finished, select the Done button on the right side, and then press the ◄ button. The pop-up reappears.
6. Select OK, and then press the ◄ button. The new folder appears in the list of apps on the left side of the screen.

Move to Folder

Move to Folder lets you move apps to the folder of your choice.

1. On the Downloaded screen, use the ▲► buttons to go to Edit at the top of the screen, and then press the ◄ button.
2. Select Move to Folder, and then press the ◄ button. The Move to Folder screen appears.
3. Use the ►◄▼▲ buttons to move to an app, and then press the ◄ button to select the app. A check appears in the upper left corner of the app.
4. To deselect an app, press the ◄ button. The check disappears.
5. Repeat Step 3 to select additional apps.

I NOTES I

- To select all the downloaded apps, select Select All at the top right of the screen, and then press the ◄ button. To deselect all the apps, select Deselect All at the top right of the screen, and then press the ◄ button.
6. When done, select Select folder at the top of the screen, and then press the ◄ button. The Select folder pop-up appears.
7. In the Select folder pop-up, use the ▲▼ buttons to select the folder you want to move the apps you selected to and then press the ◄ button.
8. The Apps Moved pop up appears. Press the ◄ button.
9. To open a folder, use the ▲▼◄► buttons to highlight the folder, and then press the ◄ button.

Rename Folder

Rename Folder lets you rename an existing folder.

1. On the Downloaded screen, use the ▲► buttons to go to Edit at the top of the screen, and then press the ◄ button.
2. Select Rename Folder, and then press the ◄ button. The Rename Folder screen appears, and a folder is highlighted.
3. Use the ▲▼◄► buttons to highlight a folder of your choice, and then press the ◄ button. The Rename pop-up appears.
4. Press the ◄ button. The keyboard appears.
5. Enter the new name for the folder. When finished, select Done on the right side, and then press the ◄ button. The Rename pop-up reappears displaying the new name.
6. Select OK, and then press the ◄ button. The folder is renamed.
7. Select Close on the right side of the screen, and then press the ◄ button.
**Delete**

Delete lets you delete apps and folders from the My Apps screen. If there are apps in a folder, both the folder and the apps are deleted together. Delete removes apps permanently. If you decide you want to use an app you deleted, you will need to download it again.

1. On the Downloaded screen, use the ▲► buttons to go to Edit at the top of the screen, and then press the □ button.
2. Select Delete, and then press the □ button. The Delete screen appears.
3. Use the ▲▼◄► buttons to move to an app, or folder and then press the □ button to select. A check appears in the upper left corner of the app or folder you selected.
4. To deselect an app, press the □ button. The check disappears.
5. Repeat Step 3 to select additional apps or folders.

**NOTES**

- To select all the downloaded apps, select Select All at the top right of the screen, and then press the □ button. To deselect all the apps, select Deselect All at the top right of the screen, and then press the □ button.
6. After you have made all your selections, select Delete at the top of the screen, and then press the □ button. The Delete pop-up appears.
7. Select Yes, and then press the □ button. All the apps you selected are deleted.

**NOTES**

- You cannot immediately delete a locked app or folder. If you select a locked app or folder to delete, when you perform Step 7, the Lock Service pop-up appears. Enter the Security PIN into the pop-up, and then press the □ button. The lock will be released and the app or folder will be deleted.

---

**Update Apps**

Update Apps automatically searches the Internet for updated versions of the apps you have downloaded and updates them if it finds newer versions.

1. On the Downloaded screen, use the ▲► buttons to go to Edit at the top of the screen, and then press the □ button.
2. Select Update Apps, and then press the □ button.
3. The unit searches the Internet for newer versions of your apps. If there are new apps, the Update Apps pop-up appears.
4. To download the update for a particular app, highlight the app, and then press the □ button. A check appears to the left of the app.
5. To deselect the app, highlight it, and then press the □ button.

**NOTES**

- To select all the updates, select Select All on the right of the pop-up, and then press the □ button. To deselect all the updates, select Deselect All, and then press the □ button.
6. After you have selected the updates you want to download, select Update on the right side of the pop-up, and then press the □ button.
7. The unit downloads the updates you have chosen. A download bar appears in each app icon as the update for that app is downloaded. The download is complete when the download bars disappear.
Screen Mirroring

The Screen Mirroring function lets you view the screen of your smart phone or android tablet on the TV you have connected to the Blu-ray player.

1. With the Blu-ray’s Home screen displayed, press the BLUE (D) button on the remote. The Screen Mirroring pop-up appears.
2. Launch AllShare Cast or Miracast on your device.
3. On your device, find the name of the Blu-ray player in the list of available devices and then select it.
4. The TV will display a PIN. Enter the PIN into your device.
5. The TV displays a connecting message (for example, Connecting to Android_92gb...) and then displays the connected message.
6. In a few moments, the screen of your device appears on the TV screen.

I NOTES I

- When you are using the Screen Mirroring function, video stuttering or audio dropouts may occur, depending on your environment.
- Before using the Screen Mirroring function, confirm that your smart phone has a compatible function. Depending on your smart phone, the Screen Mirroring function may have a different name (AllShare Cast, etc.).
- Bluetooth transmissions can interfere with the Screen Mirroring signal. Before using the Screen Mirroring function, we strongly recommend that you turn off the Bluetooth function on your smart phone or smart device (tablet, etc.).

Using the Web Browser

You can access the Internet using the Web Browser application.

Select Web Browser on the Home screen, and then press the button.

I NOTES I

- When you run the Web Browser with the player connected by HDMI to a BD Wise compatible TV - and BD Wise is on - the browser is maximized to fill the screen and the TV’s resolution is set to the optimal resolution automatically.
- The Web Browser is not compatible with Java applications.
- If you attempt to download a file, and the file cannot be saved, an error message will appear.
- E-commerce (purchasing products online) is not supported.
- ActiveX is not supported.
- Access may be blocked to some websites or to web browsers operated by certain businesses.

Link Browsing and Pointer Browsing

The Web Browser provides two types of browsing, Pointer Browsing and Link Browsing. When you launch the browser for the first time, Pointer Browsing is active. If you are using a mouse to navigate in the Web Browser, we recommend leaving Pointer Browsing active. If you are using your remote to navigate in the Web Browser, we recommend that you replace Pointer Browsing with Link Browsing. Link Browsing moves a highlight from one link to the next in the Web Browser and is much faster than Pointer Browsing if you are using your remote.

To activate Link Browsing, follow these steps:

1. Use the ▲▼◄► buttons on your remote to move the pointer to the Link Browser icon on the top right of the screen. The Link Browser icon is the third icon from the right. The pointer will be in the correct position if the icon turns blue and the words “Link Browser” appear on the screen.
2. Press the button. Link Browsing is activated and will remain active whenever you bring up the Web Browser.
The Control Panel at a Glance

The Control Panel, which runs across the top of the screen, has a series of icons which start a number of useful functions. The icons are described below, starting with the icon on the far left of the screen.

1. : Moves to the previous page.
2. : Moves to the next web page.
3. : Displays the Bookmarks and History screen. You can bookmark the current page, select an existing bookmark, and edit and delete bookmarks. You can also view your browsing history and select a page to revisit.
4. : Moves to the Home screen of the Web Browser.
5. : Lets you enter a page address manually using the keyboard pop-up.
6. : Reloads the current page so that it is refreshed on the screen.
7. : Adds the current page to your bookmarks.
8. : Lets you search for information by entering words or characters using the keyboard pop-up. See Using the Keyboard Pop-up on page 52.
9. : Lets you enlarge or shrink the screen by various percentages.
10. : Turns on the PIP function.
11. : Lets you switch between Pointer Browsing and Link Browsing.
12. : Lets you configure the Browser’s settings. See Using the Settings Menu on page 53.
13. : Closes the Web Browser.

Using the Keyboard Pop-up

When you click the or access a data or text entry field, and then press the button, the keyboard pop-up appears.

To use the keyboard pop-up with your remote, follow these steps:

1. Use the buttons on your remote to move the highlight to a letter or number of your choice.
2. Press the button to enter the letter or number into the entry field.
3. To access capital letters, move the highlight to the key on the top left, and then press the button. Press the button again with the key highlighted to access small letters again.
4. To access symbols and additional punctuation marks, highlight the button on the left, and then press the button.
5. To delete a character you entered, move the highlight to the button, and then press the button.
6. To delete all the characters you entered, move the highlight to the Clear button, and then press the button.
7. When finished entering, move the highlight to the Done button, and then press the button.
| NOTES |

- If you have a wireless keyboard connected to your player, you can use the wireless keyboard to enter letters, numbers, symbols, and punctuation. Note that the wireless keyboard will work only when the keyboard popup appears and can only be used to enter letters, numbers, symbols, and punctuation.

### Options on the Keyboard Pop-Up

To access the keyboard pop-up options, highlight the button on the bottom left of the keyboard, and then press the button.

<table>
<thead>
<tr>
<th>Language</th>
<th>Select the language for the keyboard. You can select English, French, Russian, etc.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Recommended Text</td>
<td>The keyboard will suggest recommended words as you enter text. You can turn this function On or Off.</td>
</tr>
<tr>
<td>Predict Next Letter</td>
<td>The keyboard will predict the next letter as you enter letters. The predictions appear in a ring around the letter you have just entered. You can select a predicted letter or move to another letter. You can turn this function On or Off.</td>
</tr>
</tbody>
</table>

### Using the Setting Menu

The Setting menu contains functions that control how the Browser operates and Browser security functions. To open the Setting menu, highlight the icon in the Control Panel, and then press the button. To select an option in the setting menu, highlight the option, and then press the button.

<table>
<thead>
<tr>
<th>Enable/Disable Grabbing</th>
<th>Turns the Grabber function on and off. When the Grabber function is on, you can move a web page up and down without dragging the scroll bar. The Grabber function is only available in Pointer Browsing.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reading Tools</td>
<td>Provides an easy-to-read page by enlarging the main text. This function is not available for all pages.</td>
</tr>
<tr>
<td>Approved Sites</td>
<td>Lets you restrict your children’s access to inappropriate web pages by allowing access only to the web sites you have registered. Every time you access this function, the PIN screen appears. The first time you access this function, enter the default PIN, 0000 using the number buttons on your remote. You can change the PIN using the Reset password for the Approved Sites function. See below. <strong>Approved Sites Feature</strong>: Turns the Approved Sites function on or off. <strong>Reset password for Approved Sites</strong>: Change the Approved Sites password. <strong>Add current site</strong>: Lets you add the currently displayed web site to the Approved Sites list. <strong>Manage Approved Sites</strong>: Lets you key in URLs to add to the Approved Sites List and delete sites from the Approved Sites list. If you turn this function on and have not added any sites to the Approved Sites list, you will not be able to access any Internet sites.</td>
</tr>
</tbody>
</table>
### Private Browsing On/Off
Enable or disable the Privacy mode. When the Privacy mode is enabled, the browser does not retain the URLs of sites you visit. If you want to enable Privacy mode, select **OK**. If the Privacy mode is running, the “Stop” icon appears in front of the URL at the top of the screen. To disable Privacy mode, select it again when Privacy mode is enabled.

### Web Browser Setting
- **Set as homepage**: You can set the Browser’s home page.
- **Pop-up Block**: Turns the Popup Block on and off.
- **Ad Block**: You can determine whether to block advertisements and select the URLs for which advertisements are blocked.
- **General**: You can delete personal information such as website history and browsing data (cookies, etc.), and reset all web browser settings to their factory defaults.
- **Encoding**: You can set the Encoding setting for web pages to Automatic or select the encoding format manually from a list.
- **Pointer**: You can set the speed of the cursor when the cursor is set to Pointer and turn Smart Cursor **On** and **Off**.
- **Browser Information**: Displays the version number and copyright information for the Web Browser.

### Help
Provides basic information about the operation of the Web Browser.

### Linking Your Internet Service Accounts to the Player
The Link Service Accounts function lets you link your player to your accounts with Internet services such as Pandora so that the player can log you in to the service automatically when you start the app for that service.

To create a service account link, follow these steps:

1. On the Home screen, press the **RED (A)** button on your remote to log in to your Samsung Account.
2. After you have logged in, press the **RED (A)** button on your remote again.
3. Select **Link Service Accounts** in the My Account pop-up, and then press the **v** button.
4. On the Link Service Accounts screen, select the service you want to link to the player, and then press the **v** button.
5. Select **Register**, and then press the **v** button.
6. In the ID and Password screen, enter the ID you use to log in to the service you selected using the pop-up keyboard. When finished, select **Done**, and then press the **v** button.
7. Repeat the same process for the password. When finished select **Done**, and then press the **v** button.
8. Select **OK**, and then press the **v** button.

### NOTES
- Depending on the web site, some of the Web Browser Setting functions may not be activated. Functions that are not activated are greyed out and cannot be used.
Once the player is connected to your network, you can enjoy various movie-related service contents available on BD-LIVE compliant discs.

1. Attach a USB flash memory drive to the USB jack on the front of the player, and then check its remaining memory. The memory device must have at least 1GB of free space to accommodate the BD-LIVE services.

2. Select **Settings** on the Home screen, and then press the "v" button.

3. Select **Network**, and then press the "v" button.

4. Select **BD-Live Settings**, and then press the "v" button.

5. Select **BD Data Management**, and then press the "v" button.

6. Select **Select Device**, and then press the "v" button.

7. Select USB device, and then press the "v" button.

8. Insert a Blu-ray Disc that supports BD-LIVE.

9. Select an item from the list of BD-LIVE service contents provided by the disc manufacturer.

<table>
<thead>
<tr>
<th>NOTES</th>
</tr>
</thead>
<tbody>
<tr>
<td>▶ The way you use BD-LIVE and the provided contents may differ, depending on the disc manufacturer.</td>
</tr>
</tbody>
</table>
Compliance and Compatibility Notice

NOT ALL discs are compatible

- Subject to the restrictions described below and those noted throughout this Manual, including the Disc Type and Characteristics section of this user manual, disc types that can be played are: pre-recorded commercial BD-ROM, DVD-VIDEO, and Audio CD (CD-DA); BD-RE/-R, DVD-RW/-R; and CD-RW/-R.
- Discs other than the above cannot and/or are not intended to be played by this player. And some of the above discs may not play due to one or more reasons provided below.
- Samsung cannot assure that this player will play every disc bearing the BD-ROM, BD-RE/-R, DVD-VIDEO, DVD-RW/-R, DVD+RW/+R and CD-RW/-R logos, and this player may not respond to all operating commands or operate all features of every disc. These and other disc compatibility and player operation issues with new and existing format discs are possible because:
  - Blu-ray is a new and evolving format and this player may not operate all features of Blu-ray Discs because some features may be optional, additional features may have been added to the Blu-ray Disc format after the production of this player, and certain available features may be subject to delayed availability;
  - not all new and existing disc format versions are supported by this player;
  - some discs are produced in a manner that allows specific or limited operation and feature during playback;
  - some features may be optional, additional features may have been added after the production of this player or certain available features may be subject to delayed availability;
  - some discs bearing the BD-ROM, BD-RE/-R, DVD-VIDEO, DVD-RW/-R, DVD+RW/+R and CD-RW/-R logos may still be non-standardized discs;
  - some discs may not be played depending on their physical state or recording conditions;
  - problems and errors can occur during the creation of Blu-ray Disc, DVD software and/or the manufacture of discs;
  - this player operates differently than a standard DVD player or other AV equipment; and/or
  - for reasons noted throughout this user manual and for other reason(s) discovered and posted by SAMSUNG customer care center.
- If you encounter disc compatibility or player operation problems, please contact SAMSUNG customer care center. You may also contact SAMSUNG customer care center for possible updates on this player.
- For additional information on playback restrictions and disc compatibility, refer to the Precautions, Before Reading the user manual, Disc Types and Characteristics, and Before Playing sections of this user manual.

**For Blu-ray Disc Player progressive scan output**: CONSUMERS SHOULD NOTE THAT NOT ALL HIGH DEFINITION TELEVISION SETS ARE FULLY COMPATIBLE WITH THIS PRODUCT AND MAY CAUSE ARTIFACTS TO BE DISPLAYED IN THE PICTURE. IN CASE OF PROGRESSIVE SCAN PICTURE PROBLEMS, IT IS RECOMMENDED THAT THE USER SWITCH THE CONNECTION TO THE ‘STANDARD DEFINITION’ OUTPUT. IF THERE ARE QUESTIONS REGARDING OUR TV SET COMPATIBILITY WITH THIS PRODUCT, PLEASE CONTACT OUR CUSTOMER SERVICE CENTER.
Copy Protection

- Because AACS (Advanced Access Content System) is approved as content protection system for Blu-ray Disc format, similar to use of CSS (Content Scramble System) for DVD format, certain restrictions are imposed on playback, analog signal output, etc., of AACS protected contents. The operation of this product and restrictions on this product may vary depending on your time of purchase as those restrictions may be adopted and/or changed by AACS after the production of this product. Furthermore, BD-ROM Mark and BD+ are additionally used as content protection system for Blu-ray Disc format, which imposes certain restrictions including playback restrictions for BD-ROM Mark and/or BD+ protected contents. To obtain additional information on AACS, BD-ROM Mark, BD+, or this product, please contact SAMSUNG customer care center.

- Many Blu-ray Disc/DVDs are encoded with copy protection. Because of this, you should only connect your Player directly to your TV, not to a VCR. Connecting to a VCR results in a distorted picture from copy-protected Blu-ray Disc/DVDs.

- Under the U.S. Copyright laws and Copyright laws of other countries, unauthorized recording, use, display, distribution, or revision of television programs, videotapes, Blu-ray Discs, DVDs, and other materials may subject you to civil and/or criminal liability.

- **Cinavia Notice**: This product uses Cinavia technology to limit the use of unauthorized copies of some commercially-produced film and videos and their soundtracks. When a prohibited use of an unauthorized copy is detected, a message will be displayed and playback or copying will be interrupted.

  More information about Cinavia technology is provided at the Cinavia Online Consumer Information Center at http://www.cinavia.com. To request additional information about Cinavia by mail, send a postcard with your mailing address to: Cinavia Consumer Information Center, P.O. Box 86851, San Diego, CA, 92138, USA.

  This product incorporates proprietary technology under license from Verance Corporation and is protected by U.S. Patent 7,369,677 and other U.S. and worldwide patents issued and pending as well as copyright and trade secret protection for certain aspects of such technology. Cinavia is a trademark of Verance Corporation. Copyright 2004-2010 Verance Corporation. All rights reserved by Verance. Reverse engineering or disassembly is prohibited.

Network Service Disclaimer

All content and services accessible through this device belong to third parties and are protected by copyright, patent, trademark and/or other intellectual property laws. Such content and services are provided solely for your personal noncommercial use. You may not use any content or services in a manner that has not been authorized by the content owner or service provider. Without limiting the foregoing, unless expressly authorized by the applicable content owner or service provider, you may not modify, copy, republish, upload, post, transmit, translate, sell, create derivative works, exploit, or distribute in any manner or medium any content or services displayed through this device.
THIRD PARTY CONTENT AND SERVICES ARE PROVIDED "AS IS." SAMSUNG DOES NOT WARRANT CONTENT OR SERVICES SO PROVIDED, EITHER EXPRESSLY OR IMPLIEDLY, FOR ANY PURPOSE. SAMSUNG EXPRESSLY DISCLAIMS ANY IMPLIED WARRANTIES, INCLUDING BUT NOT LIMITED TO, WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. SAMSUNG DOES NOT GUARANTEE THE ACCURACY, VALIDITY, TIMELINESS, LEGALITY, OR COMPLETENESS OF ANY CONTENT OR SERVICE MADE AVAILABLE THROUGH THIS DEVICE AND UNDER NO CIRCUMSTANCES, INCLUDING NEGLIGENCE, SHALL SAMSUNG BE LIABLE, WHETHER IN CONTRACT OR TORT, FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL OR CONSEQUENTIAL DAMAGES, ATTORNEY FEES, EXPENSES, OR ANY OTHER DAMAGES ARISING OUT OF, OR IN CONNECTION WITH, ANY INFORMATION CONTAINED IN, OR AS A RESULT OF THE USE OF ANY CONTENT OR SERVICE BY YOU OR ANY THIRD PARTY, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

Third party services may be terminated or interrupted at any time, and Samsung makes no representation or warranty that any content or service will remain available for any period of time. Content and services are transmitted by third parties by means of networks and transmission facilities over which Samsung has no control. Without limiting the generality of this disclaimer, Samsung expressly disclaims any responsibility or liability for any interruption or suspension of any content or service made available through this device.

Samsung is neither responsible nor liable for customer service related to the content and services. Any question or request for service relating to the content or services should be made directly to the respective content and service providers.

**License**

- Manufactured under license from Dolby Laboratories. Dolby and the double-D symbol are registered trademarks of Dolby Laboratories.

- Manufactured under license under U.S. Patent Nos: 5,956,674; 5,974,380; 6,226,616; 6,487,535; 7,212,872; 7,333,929; 7,392,195; 7,272,567 & other U.S. and worldwide patents issued & pending. DTS-HD, the Symbol, & DTS-HD and the Symbol together are registered trademarks & DTS-HD Master Audio is a trademark of DTS, Inc. Product includes software. © DTS, Inc. All Rights Reserved.

- The terms HDMI and HDMI High-Definition Multimedia Interface, and the HDMI Logo are trademarks or registered trademarks of HDMI Licensing LLC in the United States and other countries.

- Oracle and Java are registered trademarks of Oracle and/or its affiliates. Other names may be trademarks of their respective owners.

- Open Source License Notice
  - In the case of using open source software, Open Source Licenses are available on the product menu.

- Blu-ray Disc™, Blu-ray™ and the logos are trademarks of the Blu-ray Disc Association.
Additional Information

Notes

<table>
<thead>
<tr>
<th>Settings</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>3D Settings</strong></td>
</tr>
<tr>
<td>• For some 3D discs, to stop a movie during 3D playback, press the ( \text{STOP} ) button once. The movie stops and the 3D mode option is de-activated.</td>
</tr>
<tr>
<td>To change a 3D option selection when you are playing a 3D movie, press the ( \text{STOP} ) button once. The Blu-ray menu appears. Press the ( \text{STOP} ) button again, then select 3D Settings in the Blu-ray menu.</td>
</tr>
<tr>
<td>• Depending on the content and the position of the picture on your TV screen, you may see vertical black bars on the left side, right side, or both sides.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>TV Aspect Ratio</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>• Depending on the disc type, some aspect ratios may not be available.</td>
</tr>
<tr>
<td>• If you select an aspect ratio and option that is different than the aspect ratio of your TV screen, the picture might appear to be distorted.</td>
</tr>
<tr>
<td>• If you select the 16:9 Original, your TV may display 4:3 Pillarbox (black bars on sides of picture).</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>BD Wise (Samsung Players only)</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>• When BD Wise is on, the Resolution setting automatically defaults to BD Wise and BD Wise appears in the Resolution menu.</td>
</tr>
<tr>
<td>• If the player is connected to a device that does not support BD Wise, you cannot use the BD Wise function.</td>
</tr>
<tr>
<td>• For proper operation of BD Wise, set the BD Wise option of both the player and the TV to On.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Digital Output</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>• Be sure to select the correct Digital Output or you will hear no sound or just loud noise.</td>
</tr>
<tr>
<td>• If the HDMI device (AV receiver, TV) is not compatible with compressed formats (Dolby Digital, DTS), the audio signal outputs as PCM.</td>
</tr>
<tr>
<td>• Regular DVDs do not have BONUSVIEW audio and Navigation Sound Effects.</td>
</tr>
<tr>
<td>• Some Blu-ray Discs do not have BONUSVIEW audio and Navigation Sound Effects.</td>
</tr>
<tr>
<td>• This Digital Output setup does not affect the HDMI audio output to your TV. It affects the optical and HDMI audio output when your player is connected to an AV receiver.</td>
</tr>
<tr>
<td>• If you play MPEG audio soundtracks, the audio signal outputs as PCM regardless of your Digital Output selections (PCM or Bitstream).</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>PCM Downsampling</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>• Even when PCM Downsampling is set to Off, some discs will only output downsampled audio through the optical digital output.</td>
</tr>
<tr>
<td>• HDMI</td>
</tr>
<tr>
<td>- If your TV is not compatible with compressed multi-channel formats (Dolby Digital, DTS), the player may output PCM 2ch downmixed audio even though you selected Bitstream (either Reencoded or Unprocessed) in the setup menu.</td>
</tr>
<tr>
<td>- If your TV is not compatible with PCM sampling rates over 48kHz, the player may output 48kHz.</td>
</tr>
</tbody>
</table>
### Appendix

#### Settings

<table>
<thead>
<tr>
<th>BD-LIVE Internet Connection</th>
</tr>
</thead>
<tbody>
<tr>
<td>• What is a valid certificate?</td>
</tr>
<tr>
<td>When the player uses BD-LIVE to send the disc data and a request to the server to certify the disc, the server uses the transmitted data to check if the disc is valid and sends the certificate back to the player.</td>
</tr>
<tr>
<td>• The Internet connection may be restricted while you are using BD-LIVE contents.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>BD Data Management</th>
</tr>
</thead>
<tbody>
<tr>
<td>• In the external memory mode, disc playback may be stopped if you disconnect the USB device in the middle of playback.</td>
</tr>
<tr>
<td>• Only those USB devices formatted in the FAT file system (DOS 8.3 volume label) are supported. We recommend you use USB devices that support USB 2.0 protocol with 4 MB/sec or faster read/write speed.</td>
</tr>
<tr>
<td>• The Resume Play function may not work after you format the storage device.</td>
</tr>
<tr>
<td>• The total memory available to BD Data Management may differ, depending on conditions.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Anynet+ (HDMI-CEC)</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Depending on your TV, certain HDMI output resolutions may not work. Please refer to the user manual of your TV.</td>
</tr>
<tr>
<td>• This function is not available if the HDMI cable does not support CEC.</td>
</tr>
<tr>
<td>• If your Samsung TV has an Anynet+ logo, then it supports the Anynet+ function.</td>
</tr>
</tbody>
</table>

#### Media Play

<table>
<thead>
<tr>
<th>Selecting the Audio Language</th>
</tr>
</thead>
<tbody>
<tr>
<td>• The ◄► indicator will not appear on the screen if the BONUSVIEW section does not contain any BONUSVIEW audio settings.</td>
</tr>
<tr>
<td>• The languages available through the Audio Language function depend on the languages that are encoded on the disc. This function or certain languages may not be available.</td>
</tr>
<tr>
<td>• Some Blu-ray Discs may allow you to select either the PCM or Dolby Digital audio soundtrack in English.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Selecting the Subtitle Language</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Depending on the Blu-ray Disc / DVD, you may be able to change the subtitle language in the Disc Menu. Press the <strong>DISC MENU</strong> button.</td>
</tr>
<tr>
<td>• This function depends on the selection of subtitles that are encoded on the disc and may not be available on all Blu-ray Discs/DVDs.</td>
</tr>
<tr>
<td>• Information about the main feature BONUSVIEW mode will also appear if the Blu-ray Disc has a BONUSVIEW section.</td>
</tr>
<tr>
<td>• This function changes both the primary and secondary subtitles at the same time.</td>
</tr>
<tr>
<td>• The total number of primary and secondary subtitles are displayed respectively.</td>
</tr>
<tr>
<td>• If you press the <strong>SUBTITLE</strong> button on the remote control, the subtitle bar appears. Press the <strong>RETURN</strong> button to remove the subtitle bar.</td>
</tr>
</tbody>
</table>
## Resolution according to the contents type

<table>
<thead>
<tr>
<th>Setup</th>
<th>Contents Type</th>
<th>Blu-ray Disc</th>
<th>E-contents/Digital contents</th>
</tr>
</thead>
<tbody>
<tr>
<td>Auto</td>
<td>BD Wise</td>
<td>Resolution of Blu-ray Disc</td>
<td>1080p@60F</td>
</tr>
<tr>
<td></td>
<td>Movie Frame : Auto</td>
<td>1080p@24F</td>
<td>1080p@24F</td>
</tr>
<tr>
<td></td>
<td>Movie Frame : Off</td>
<td>Max. Resolution of TV input</td>
<td>Max. Resolution of TV input</td>
</tr>
<tr>
<td></td>
<td>Movie Frame : Auto (24Fs)</td>
<td>1080p@24F</td>
<td>1080p@24F</td>
</tr>
<tr>
<td></td>
<td>1080p (Movie Frame : Off)</td>
<td>1080p@60F</td>
<td>1080p@60F</td>
</tr>
<tr>
<td></td>
<td>1080i</td>
<td>1080i</td>
<td>1080i</td>
</tr>
<tr>
<td></td>
<td>720p</td>
<td>720p</td>
<td>720p</td>
</tr>
<tr>
<td></td>
<td>480p</td>
<td>480p</td>
<td>480p</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Setup</th>
<th>Contents Type</th>
<th>DVD</th>
</tr>
</thead>
<tbody>
<tr>
<td>Auto</td>
<td>BD Wise</td>
<td>480i</td>
</tr>
<tr>
<td></td>
<td>Movie Frame : Auto</td>
<td>DVD 24Fs Conversion : Auto</td>
</tr>
<tr>
<td></td>
<td>Movie Frame : Off</td>
<td>DVD 24Fs Conversion : Off</td>
</tr>
<tr>
<td></td>
<td>1080p</td>
<td>1080p@60F</td>
</tr>
<tr>
<td></td>
<td>1080i</td>
<td>1080i</td>
</tr>
<tr>
<td></td>
<td>720p</td>
<td>720p</td>
</tr>
<tr>
<td></td>
<td>480p</td>
<td>480p</td>
</tr>
</tbody>
</table>

### NOTES

- If the TV you connected to the player does not support Movie Frame or the resolution you selected, the message "If no pictures are shown after selecting 'Yes', please wait for 15 seconds to return to the previous resolution. Do you want to change the resolution?" appears. If you select Yes, the TV’s screen will go blank for 15 seconds, and then the resolution will revert to the previous resolution automatically.

- If the screen stays blank after you have changed the resolution, remove all discs, and then press and hold the button on the top of the player for more than 5 seconds. All settings are restored to the factory default. Run the Initial Settings procedure again. Then, go to Settings > Display > Resolution in the Menu, and select the correct resolution for your TV.

- When you run the Initial Settings procedure, re-select the language and aspect ratio (screen size and format) only. Resetting does not affect your network settings, so you should be able to skip Network Setup and Software Update.

- When the factory default settings are restored, all stored user BD data will be deleted.

- The Blu-ray Disc must have the 24 frame feature for the player to use the Movie Frame (24Fs) mode.
## Appendix

### Digital Output Selection

<table>
<thead>
<tr>
<th>Setup</th>
<th>PCM</th>
<th>Bitstream (Unprocessed)</th>
<th>Bitstream (Re-encoded DTS)</th>
<th>Bitstream (Re-encoded Dolby D)</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Connection</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>HDMI supported AV receiver</td>
<td>PCM 2ch</td>
<td>PCM</td>
<td>PCM 2ch</td>
<td>DTS re-encoded</td>
</tr>
<tr>
<td>Optical</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>HDMI supported AV receiver</td>
<td>PCM 2ch</td>
<td>Dolby Digital</td>
<td>Dolby Digital</td>
<td>DTS re-encoded</td>
</tr>
<tr>
<td>Dolby Digital Plus</td>
<td>Up to PCM 7.1ch</td>
<td>PCM 2ch</td>
<td>Dolby Digital Plus</td>
<td>Dolby Digital</td>
</tr>
<tr>
<td>Digital Output Selection</td>
<td>Dolby TrueHD</td>
<td>Up to PCM 7.1ch</td>
<td>Dolby TrueHD</td>
<td>Dolby Digital</td>
</tr>
<tr>
<td>Audio Stream on Blu-ray Disc</td>
<td>DTS</td>
<td>Up to PCM 6.1ch</td>
<td>PCM 2ch</td>
<td>DTS</td>
</tr>
<tr>
<td>DTS- HD High Resolution Audio</td>
<td>Up to PCM 7.1ch</td>
<td>PCM 2ch</td>
<td>DTS- HD High Resolution Audio</td>
<td>DTS</td>
</tr>
<tr>
<td>DTS- HD Master Audio</td>
<td>Up to PCM 7.1ch</td>
<td>PCM 2ch</td>
<td>DTS- HD Master Audio</td>
<td>DTS</td>
</tr>
<tr>
<td>Audio Stream on DVD</td>
<td>PCM</td>
<td>PCM 2ch</td>
<td>PCM 2ch</td>
<td>PCM 2ch</td>
</tr>
<tr>
<td>PCM</td>
<td></td>
<td>PCM 2ch</td>
<td>PCM 2ch</td>
<td>PCM 2ch</td>
</tr>
<tr>
<td>Dolby Digital</td>
<td></td>
<td>Dolby Digital</td>
<td>Dolby Digital</td>
<td>Dolby Digital</td>
</tr>
<tr>
<td>DTS</td>
<td></td>
<td>DTS</td>
<td>DTS</td>
<td>DTS</td>
</tr>
<tr>
<td>Definition for Blu-ray Disc</td>
<td>Any</td>
<td>Decodes the main feature audio and BONUSVIEW audio stream together into PCM audio and adds Navigation Sound Effects.</td>
<td>Outputs only the main feature audio stream so that your AV receiver can decode the audio bitstream. You will not hear BONUSVIEW audio or Navigation Sound Effects.</td>
<td>Decodes the main feature audio and BONUSVIEW audio stream together into PCM audio and adds Navigation Sound Effects, then re-encodes the PCM audio into DTS bitstream.</td>
</tr>
</tbody>
</table>

* If the Source Stream is 2ch or mono, "Re-encoded Dolby D" Settings are not applied. Output will be PCM 2ch.

Blu-ray Discs may include three audio streams:
- **Main Feature Audio**: The audio soundtrack of the main feature.
- **BONUSVIEW audio**: An additional soundtrack such as the director or actor’s commentary.
- **Navigation Sound Effects**: When you choose some menu navigation, Navigation Sound Effects may sound. Navigation Sound Effects are different on each Blu-ray Disc.
## Troubleshooting

Before requesting service, please try the following solutions.

<table>
<thead>
<tr>
<th>PROBLEM</th>
<th>SOLUTION</th>
</tr>
</thead>
</table>
| No operation can be performed with the remote control.| • Check the batteries in the remote control. They may need replacing.  
• Operate the remote control at a distance of no more than 20 feet from the player.  
• Remove the batteries and hold down one or more buttons for several minutes to drain the microprocessor inside the remote control to reset it. Reinstall the batteries and try to operate the remote control again. |
| The disc does not play.                               | • Ensure that the disc is installed with the label side facing up.  
• Check the region number of the Blu-ray Disc/DVD.                                                              |
| The disc Menu does not appear.                         | • Ensure that the disc has disc menus.                                                                                                   |
| The prohibition message appears on the screen.        | • This message appears when an invalid button is pressed.  
• The Blu-ray Disc/DVD’s software doesn’t support the feature (e.g., angles).  
• You’ve requested a title or chapter number or search time that is out of range.                                    |
| Play mode differs from the Setup Menu selection.      | • Some of the functions selected in the Setup Menu may not work properly if the disc is not encoded with the corresponding function.  |
| The screen ratio cannot be changed.                   | • The Screen Ratio is fixed on your Blu-ray Disc/DVD.  
• This is not a problem with the player.                                                                          |
| No audio.                                             | • Make sure you have selected the correct Digital Output in the Audio Options Menu.                                                        |
| The screen is blank.                                  | • If the HDMI output is set to a resolution your TV cannot support (for example, 1080p), you may not see a picture on your TV.  
• Press the ■ button (on top panel) for more than 5 seconds with no disc inside. All settings will revert to the factory settings.  
• When the factory default settings are restored, all stored user BD data will be deleted.                       |
| Forgot password.                                      | • Press the ■ button (on top panel) for more than 5 seconds with no disc inside. All settings including the password will revert to the factory settings. Don’t use this unless absolutely necessary.  
• When the factory default settings are restored, all stored user BD data will be deleted.                       |
<table>
<thead>
<tr>
<th>PROBLEM</th>
<th>SOLUTION</th>
</tr>
</thead>
</table>
| The picture is noisy or distorted.   | • Make sure that the disc is not dirty or scratched.  
• Clean the disc.                       |
| No HDMI output.                      | • Check the connection between the TV and the HDMI jack of the player.  
• Check if your TV supports the 480p, 720p, 1080i or 1080p HDMI input resolution. |
| Abnormal HDMI output screen.         | • If random noise appears on the screen, it means that TV does not support HDCP (High-bandwidth Digital Content Protection). |
| If you experience other problems.    | • Go to the table of contents and find the section of the user manual that contains information about the feature you are having the problem with, and then follow the procedure again.  
• If you still cannot resolve the problem, please contact your nearest Samsung authorized service center. |
| **AllShare function**                |                                                                                                    |
| I can see folders shared through AllShare, but I cannot see the files. | • AllShare only shows Video, Photo, and Music files. Other types of files are not displayed. |
| The video plays intermittently.      | • Check if the network is stable.  
• Check if the network cable is properly connected and if the network is not overloaded.  
• The wireless connection between the AllShare compatible device and the player is unstable.  
  Check the connection.               |
| The AllShare connection between the player and the PC is unstable. | • IP addresses within the same subnetwork should be unique.  
  If they are not, IP interference can cause this phenomenon.  
• Check if you have a firewall enabled.  
  If so, disable the firewall function. |
### PROBLEM | SOLUTION
--- | ---
**BD-LIVE** | - Test whether the network connection is working using the Network Status function. (See page 21)
- Check whether a USB memory device is connected to the player.
- The memory device must have at least 1GB of free space to accommodate the BD-LIVE service.
  You can check the available size in BD Data Management. (See page 22)
- See if the BD-LIVE Internet Connection option is set to Allow(All).
- If all above fails, contact the contents provider or update to the player to the latest firmware.

When using the BD-LIVE service, an error occurs. | - The memory device must have at least 1GB of free space to accommodate the BD-LIVE service.
  You can check the available size in BD Data Management. (See page 22)

### NOTES
- When the factory default settings are restored, all stored user BD data will be deleted.

### Repairs
If you contact us to repair your player, an administration fee may be charged if either:

1. An engineer is called out to your home at your request and there is no defect in the product.
2. You bring the unit to a repair center and there is no defect in the product.

We will provide you with the amount of the administration fee before we make a home visit or begin any work on your player.

We recommend you read this manually thoroughly, search for a solution on line at www.samsung.com, or contact Samsung Customer Care at 1-800-SAMSUNG (726-7864) before seeking to repair your player.
# Appendix

## Specifications

<table>
<thead>
<tr>
<th>General</th>
<th>AC110-120V 50/60Hz</th>
</tr>
</thead>
<tbody>
<tr>
<td>Power Requirements</td>
<td>17W</td>
</tr>
<tr>
<td>Weight</td>
<td>2.6 lbs</td>
</tr>
<tr>
<td>Dimensions</td>
<td>14.2 (W) X 7.7 (D) X 1.6 (H) inches</td>
</tr>
<tr>
<td>Operating Temperature Range</td>
<td>+41°F to +95°F</td>
</tr>
<tr>
<td>Operating Humidity Range</td>
<td>10 % to 75 %</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>USB</th>
<th>USB 2.0</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type A</td>
<td></td>
</tr>
<tr>
<td>DC output</td>
<td>5V 500mA Max.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>HDMI</th>
<th>2D : 1080p, 1080i, 720p, 480p</th>
</tr>
</thead>
<tbody>
<tr>
<td>Video</td>
<td>3D : 1080p, 720p</td>
</tr>
<tr>
<td>Audio</td>
<td>PCM, Bitstream</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Audio Output</th>
<th>Digital Audio Output</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Optical</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Network</th>
<th>100BASE - TX Terminal</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ethernet</td>
<td></td>
</tr>
<tr>
<td>Wireless LAN</td>
<td>Built-in</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Security</th>
<th>WEP (OPEN/SHARED)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>WPA-PSK (TKIP/AES)</td>
</tr>
<tr>
<td></td>
<td>WPA2-PSK (TKIP/AES)</td>
</tr>
</tbody>
</table>

| WPS(PBC)     | Supported            |

- Network speeds equal to or below 10Mbps are not supported.
- Design and specifications are subject to change without prior notice.
- Weight and dimensions are approximate.
- Dispose unwanted electronics through an approved recycler.
  To find the nearest recycling location, go to our website: www.samsung.com/recyclingdirect or call, (877) 278 - 0799.
LIMITED WARRANTY TO ORIGINAL PURCHASER

This SAMSUNG brand product, as supplied and distributed by SAMSUNG and delivered new, in the original carton to the original consumer purchaser, is warranted by SAMSUNG against manufacturing defects in materials and workmanship for a limited warranty period of:

One (1) Year parts and Labor*
(*90 Days Parts and Labor for Commercial Use)

This limited warranty begins on the original date of purchase, and is valid only on products purchased and used in the United States. To receive warranty service, the purchaser must contact SAMSUNG for problem determination and service procedures. Warranty service can only be performed by a SAMSUNG authorized service center. The original dated bill of sale must be presented upon request as proof of purchase to SAMSUNG or SAMSUNG’s authorized service center. Transportation of the product to and from the service center is the responsibility of the purchaser.

SAMSUNG will repair or replace this product, at our option and at no charge as stipulated herein, with new or reconditioned parts or products if found to be defective during the limited warranty period specified above. All replaced parts and products become the property of SAMSUNG and must be returned to SAMSUNG. Replacement parts and products assume the remaining original warranty, or ninety (90) days, whichever is longer.

SAMSUNG’s obligations with respect to software products distributed by SAMSUNG under the SAMSUNG brand name are set forth in the applicable end user license agreement. Non-SAMSUNG hardware and software products, if provided, are on an "AS IS" basis. Non-SAMSUNG manufacturers, suppliers, publishers, and service providers may provide their own warranties.

This limited warranty covers manufacturing defects in materials and workmanship encountered in normal, and except to the extent otherwise expressly provided for in this statement, noncommercial use of this product, and shall not apply to the following, including, but not limited to: damage which occurs in shipment; delivery and installation; applications and uses for which this product was not intended; altered product or serial numbers; cosmetic damage or exterior finish; accidents, abuse, neglect, fire, water, lightning or other acts of nature; use of products, equipment, systems, utilities, services, parts, supplies, accessories, applications, installations, repairs, external wiring or connectors not supplied and authorized by SAMSUNG, or which damage this product or result in service problems; incorrect electrical line voltage, fluctuations and surges; customer adjustments and failure to follow operating instructions, cleaning, maintenance and environmental instructions that are covered and prescribed in the instruction book; product removal or reinstallation; reception problems and distortion related to noise, echo, interference or other signal transmission and delivery problems. SAMSUNG does not warrant uninterrupted or error-free operation of the product.

THERE ARE NO EXPRESS WARRANTIES OTHER THAN THOSE LISTED AND DESCRIBED ABOVE, AND NO WARRANTIES WHETHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE, SHALL APPLY AFTER THE EXPRESS WARRANTY PERIODS STATED ABOVE, AND NO OTHER EXPRESS WARRANTY OR GUARANTY GIVEN BY ANY PERSON, FIRM OR CORPORATION WITH RESPECT TO THIS PRODUCT SHALL BE BINDING ON SAMSUNG. SAMSUNG SHALL NOT BE LIABLE FOR LOSS OF REVENUE OR PROFITS, FAILURE TO REALIZE SAVINGS OR OTHER BENEFITS, OR ANY OTHER SPECIAL, INCIDENTAL OR CONSEQUENTIAL DAMAGES CAUSED BY THE USE, MISUSE OR INABILITY TO USE THIS PRODUCT, REGARDLESS OF THE LEGAL THEORY ON WHICH THE CLAIM IS BASED, AND EVEN IF SAMSUNG HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. NOR SHALL RECOVERY OF ANY KIND AGAINST SAMSUNG BE GREATER IN AMOUNT THAN THE PURCHASE PRICE OF THE PRODUCT SOLD BY SAMSUNG AND CAUSING THE ALLEGED DAMAGE. WITHOUT LIMITING THE FOREGOING, PURCHASER ASSUMES ALL RISK AND LIABILITY FOR LOSS, DAMAGE OR INJURY TO PURCHASER AND PURCHASER’S PROPERTY AND TO OTHERS AND THEIR PROPERTY ARISING OUT OF THE USE, MISUSE OR INABILITY TO USE THIS PRODUCT SOLD BY SAMSUNG NOT CAUSED DIRECTLY BY THE NEGLIGENCE OF SAMSUNG. THIS LIMITED WARRANTY SHALL NOT EXTEND TO ANYONE OTHER THAN THE ORIGINAL PURCHASER OF THIS PRODUCT, IS NONTRANSFERABLE AND STATES YOUR EXCLUSIVE REMEDY.

Some states do not allow limitations on how long an implied warranty lasts, or the exclusion or limitation of incidental or consequential damages, so the above limitations or exclusions may not apply to you. This warranty gives you specific legal rights, and you may also have other rights which vary from state to state.

To obtain warranty service, please contact SAMSUNG customer care center.
### QUESTIONS OR COMMENTS?

<table>
<thead>
<tr>
<th>COUNTRY</th>
<th>CALL</th>
<th>OR VISIT US ONLINE AT</th>
<th>WRITE</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td>85 Challenger Road Ridgefield Park, NJ 07660-2112</td>
</tr>
</tbody>
</table>